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F5/F6 abner/lukker Bogmeerker

I Menu Vis sindstiller du, hvordan filen vises pa skaermen
CTRLA+0 = Hele siden CTRL+1 = Originalstgrrelse CTRL+2 = Vinduesbredde

I samme menu kan du osse seette: Enkelt side, Fortlgbende eller Fortlgbende -
Dobbelsider .. Prgv, saa ser du forskellen.

Navigation
Pil til hgjre/venstre: fremad/tilbage en side
Alt+Pil Hgjre/Venstre: som i Browser: fremad/tilbage

Ctrl+— forstgrrer og Ctrl+— formindsker
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Forord

Jeg har brugt Paint Shop Pro i nasten al den tid,
der har veeret Windows pa min computer. Fra at
veere et lille teknisk program, hvor man knap
nok kunne finde en pensel at male med, har det
udviklet sig til et seerdeles alsidigt verkte;j.

Da pc'erne for et par ar siden fik sterre
harddiske og mere RAM, kom der for alvor
gang i udviklingen. Selv pa den lille
hjemmecomputer blev der plads til at arbejde
med fotografiske billeder.

Det store spring fremad for mig blev, da jeg
besluttede at pakke mine heafter ind i
firefarvede omslag. Samtidig blev det et barsk
mede med den typografiske branche, der pa det
tidspunkt vendte det hvide ud af gjnene, nar de
skulle lave film og trykplader med grafik fra en
snollet pc. Jeg fik ved flere lejligheder et
kraftigt vink med en vognstang om at anskaffe
mig en Mac-computer og levere materialet i de
anerkendte formater, dvs. bruge programmer fra
en professionel leverander som Adobe.

Pé et tidspunkt overgav jeg mig og
anskaffede grafikprogrammet Photoshop, der
viste sig at vaere helt suverent til at handtere
billeder til fire-farve-separation. Jeg har
efterhanden leert dette program ret godt at
kende, og har féet stor respekt for det. Alligevel
har jeg ikke kunnet undgé at bemarke to
vaesentlige ulemper: det er svert at finde rundt i
- og det er dyrt.

I dette lys har jeg gleedet mig over at konsta-
tere, at Paint Shop Pro, som jeg hele tiden har
haft et godt gje til, er ved at hale kraftigt ind pa
Photoshop. Der er ikke engang tale om en billig
efterligning, fordi Paint Shop Pro hele tiden har
formaet at undgé overfledige finesser, der kun
er med til at forvirre os stakkels brugere.

Det er sandsynligvis ikke det indtryk, du far,
hvis du kaster dig over en af de nyeste versioner
5 eller 6. Faktisk er programmet rigeligt
velspakket med bade det ene og det andet. Fra
version 5 kan du arbejde med /ag, masker og
animationer. Og version 6 har fiet de sakaldte
vektorer med i rygsakken. Heldigvis er
programmet sddan indrettet, at du kan leve i
lykkelig uvidenhed om disse raffinementer
uden at miste overblikket.

Jeg var allerede i gang med at skrive dette
heaefte, da jeg herte, at version 6 var pé vej. Med
stor nysgerrighed fik jeg fat pd en beta-udgave
(en gratis preveversion) for at se, om jeg nu
skulle starte helt forfra. Heldigvis ligner de to
versioner hinanden s& meget, at de metoder, jeg
anbefaler til 5'eren, sagtens kan bruges i 6'eren.
Der er kommet lidt mere pynt p4 menuerne -
smé dekorative ikoner - og et par spendende
nye varktejer, men ellers er grundideen den
samme.

Min egen erfaring siger mig, at du nemmest
leerer programmet at kende gennem eksempler.
Derfor har jeg taget mig den frihed pa forhénd
at lave fire billeder, som du kan bruge hele
vejen. Billederne kan hentes pé adressen:
www.aha.dk/psp

Det er selvfolgelig ikke serligt hofligt over
for laesere uden adgang til Internettet, men det
skulle undre mig meget, om du i givet fald ikke
kan fa din faetter eller arbejdskammerat til at
hjeelpe dig. De fire billeder kan nemt ligge pa
en almindelig diskette.

I gvrigt kan du sagtens fa det samme udbytte
ved at bruge dine egne billeder. Mona Lisa er
ingen livsbetingelse for Paint Shop Pro.

God forngjelse.

Steen Juhler
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Programmet

Paint Shop Pro er shareware og kan bruges gratis i en preveperiode pa 30 dage.

Paint Shop Pro (PSP) kan enten bestilles pa
CD-ROM eller hentes pa nettet hos:
WWw.jasc.com.
Efter installationen er programmet og de
tilherende hjelpeprogrammer klar til brug.
Hvis Paint Shop Pro bliver dit foretrukne
grafikprogram, far du brug for at kunne abne
programmet pé en nem made.

Du serger forst og fremmest for, at
der ligger en genve;j til programmet
pa dit skrivebord.

For at vaere sikker p4, at du kan finde knappen,
selv om skrivebordet er deekket af vinduer,
laver du en ekstra genvej i startmenuen.

Det gor du ved at trackke
genvejen fra skrivebordet ned pa
A Stan ||J startknappen, og slippe den dér.
by

Erngrammer 3

Faretrukne  »
25 Dokumenter »

Herved fér genvejen en
plads pa startmenuens
forste plade - lige over
Programmer - hvorfra
den nemt kan nés.

Afhangigt af hvordan din opsatning er
indstillet, starter du programmet ved enten at
klikke eller dobbeltklikke péa en genvej. PSP
dukker op i sit eget vindue med et flot logo - en
sakaldt Splash Screen:
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Hyvis du bliver treet af logoet, kan du frakoble
det ved at klikke pa File>Preferences—>
General Program Preferences > Miscel-
laneous og fjerne hakket ud for Show splash
screen when application starts.

Programvinduet er omkranset af menuer og
vearktejslinjer, hvoraf kun en begraenset del er
vist her.

% Paint Shop Pro
Eile Edit “iew |mage Colars Lavers

DEE&E 2t PO

NN egE oY

Image: Mone 2

For Help, prezs F1




Traekker du en verktejslinje vaek fra kanten og
ud pa det gra arbejdsomrade, forvandles den til
en selvstendig "flydende" boks, du kan flytte
rundt pé eller helt skjule.

Tool Palette < |
[RQ @&

Da det gré arbejdsomrade primart skal vaere
forbeholdt dine billeder, ber du spare pé
pladsen og kun lade de mest nedvendige
veerktejslinjer vere synlige. Det kan du styre
ved at veelge View—>ToolBars:

% Paint Shop Pro
File Edit g

|D = -
~ =

Toolbars |

Capture  Help
Full Scresn Edit |E_

[w]Caolar Palette
[[JContral Palette

[Hiztagran 'Wwindaow

[ Laver Palette Cancel |
[w]Status Bar

[w|Tool Bar Help |

[v] Tool Palette

I dialogboksen Toolbars kan du bestemme
udseendet ved at satte hak de enskede steder.
Rakken af knapper til de mest brugte
funktioner (lige under menuoverskrifterne) har
faet betegnelsen Tool Bar. Funktionernes
navne dukker op i en gul tekstboks, nér du ferer
markeren hen over dem:

|New| |Save| |Un|:||:|| |I:|:||:|_I,I|
DS < % 2@

Knapperne lige til venstre for Help styrer
visningen af de vigtigste Toolbars (paneler):

| Full Screen | |E|:|ntrcul|| Histu:ugram| | Help|

DO c=E Wl W

[Mormal || Tool] [Color| — Layer|

Den fuldstendige tekst under knappen med
skruengglen er: Toggle Tool Palette.

Toggle er et
engelsk ord for
en omskifter.

A= BEE
Taendt & Slukket

Nar knappen er trykket ind, er panelet synligt
(teendt) og kan skjules med et klik. Er knappen
derimod trykket ind (slukket), kan panelet atter
gores synligt med et nyt klik.

I Paint Shop Pro bruges ordet Palette i to
forskellige betydninger: dels (som her) om
en veerktojslinje, dels om den nummererede
farvelade, der er knyttet til billeder med 256
farver.

For ikke at forveksle de to betydninger vil
jeg kalde en vaerktejslinje for et panel, og
kun bruge ordet palet om farveladen.

Toggle-knapperne for de 5 paneler: Tool, Con-
trol, Color, Histogram og Layer kan ydermere
betjenes samlet med en genvej pa tastaturet.
Hovedafbryderen, der teender og slukker de
eksisterende, flydende paneler, er tabulator-
tasten Tab (som sidder til venstre for bogstavet
Q). Du kan altséa ngjes med at veelge et
passende antal paneler med knapperne én gang
for alle, og sa lejlighedsvis skjule dem alle med
et enkelt tryk pa Tab. Las mere om genveje pa
side 60.

I version 6 kan du valge, at dine Toolbars skal
vaere Automatic Roll-Ups.

Toolbars
[w] T ool Palette

FI%E nable Automatic Roll-Upsz

Det medforer, at panelerne klapper sammen til
blot en titelbjeelke, nar du ikke bruger dem.

Tuulhﬂptiunsgﬂ

Sa snart du beveeger musen hen over bjelken,
folder panelet sig automatisk ud igen. Smart!
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Kom 1 gang

I Paint Shop Pro kan du bearbejde eksisterende billeder eller lave nye billeder fra bunden.
For at komme hurtigt i gang laver du et billede af dit skrivebord og indsaetter det i programmet.

I Windows kan du lave et fotografisk aftryk af
dit skeermbillede (et screen shot) ved at trykke
pa tasten PrtScr (PrintScreen), der sidder
foroven i hejre side af tastaturet.

Du starter Paint Shop Pro og
klikker dernaest pa minimér-
knappen.

!\

Herefter ses programmet kun som en knap pa
proceslinjen nederst pa skrivebordet, som i
ovrigt skal vaere fri for vinduer. Nu laver du en
screen shot ved at trykke pa tasten PrtScr.

Klik pa Paint Shop Pro-knappen, sa
programmet atter far fuld sterrelse. Nu
indsetter du det indfangede skeermbillede ved
at veelge Edit->Paste As New Image.

X Pﬂint Shup Pro

]

k]
= .
Empty Clipboard
M

Straks dukker billedet op i sit eget vindue med
titlen Image1:

% Paint Shop Pro - Imagel
Eile Edit “iew [mage Colors Lavers

D& - ser @z

Du far billedet til at fylde mere ved at trykke pa
knappen [+ yderst til hgjre pé tastaturet. Du kan
forskyde billedet i rammen med rullepanelerne.

|ﬂ5tﬂn|“ ¥ Paint Shap Pro |

L

For Help, prezs F1

For at gore billedet mere handterligt, beskerer
du det til kun at omfatte ikonet og dets titel.

Ved at klikke pé
knappen Crop pa
veerktajspanelet bliver
din marker til en
beskaresaks, som du
kan markere et udsnit
med.

Du kan justere storrelsen af

den rektanguleere markering
ved at treekke i dens sider og
hjerner. Inde i midten bliver
markeren til en flyttepil.

Nér du er tilfreds med markeringens sterrelse
og placering, dobbeltklikker du, mens
flyttepilen er synlig. Nu beskeeres billedet.

E! Ima... =] E3

Dienne
camputer

Du kan zoome ind og ud pa billedet med L*| og
[=] -knapperne. Det forandrer ikke selve
billedet, men pavirker kun den méade, du ser det
pa.

Zoom-faktoren (her 4:1) ses i en firkantet
parentes pa billedets titelbjelke.

Pé programmets arbejdsareal kan du have
flere billeder abne pa samme tid. To billeder
kan godt have forskellig zoomfaktor, men hvis
du bruger dem sammen (hvis du f.eks. henter
farve fra det ene billede til det andet med Clone
Brush, se side 25) er det bedst med samme grad
af forsterrelse.

Cinciow [

sl e W rcd oo

Bl Image1* [4:1]

Under menupunktet
Window kan du se de

abne billeder og fa et
andet til at ligge overst
2 lm&nge? [1:1] ved at klikke pa titlen.
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Vearktojer

Panelet med de mange billedverktejer, den sakaldte Tool Palette, er normalt parkeret pa
vinduesrammen til venstre for arbejdsfladen. Da verktejerne i Tool Palette er noglen til din

billedbehandling, vil de blive gennemgéet i detaljer.

ﬁ
]
=

25 |Clone Brush Det
B |Color Replacer bogstav

pa tasta-

[~
)
[l
=

W3

Q

[l [ turet, som
Hr . aktiverer
& 5 et

= A Verkto)
% [Frechand & star anfort
P A med radt
’ / el et
& | folgende.

Bare ikke her—|

Den hurtigste made at zoome pa er dog at
trykke pa plus- eller minus-tasterne [+][=] ved
siden af tallene leengst til hgjre pé tastaturet.
Takket veere indstillingen Fit window to
image when zooming.., som du kan andre
under General Preferences, vil vinduets
storrelse lobende tilpasse sig billedet.

it Vrid og drej D

X Almindelig markar

Arrow minder meget om den oprindelige
musemarker. Hvis to billeder overlapper
hinanden pa arbejdsomradet, kan du fa det
bageste til at hoppe om foran ved at klikke pa
det med pilen.

Hvis du treekker
med musen pa et
billede, der er storre
end sit vindue, kan
du forskyde den
synlige del i
forhold til rammen.
Samtidig skifter
pilen udseende til
en hand.

E Mona_jpq M=l B3
=

Deformation-varktejet bruges til at rotere,
skalere, vride eller forvraenge et billede eller en
del af det. Veerktejets ikon kan kun aktiveres,
nar du arbejder pa et selvstendigt lag (se side
37) eller med en flydende selection (se side 26).
Er denne betingelse ikke opfyldt, ses ikonet i en
gratonet udgave.

Forst nar ikonet er synligt, kan
du klikke pa billedet og
frembringe en reekke handtag
til at traekke i. Den midterste
bjelke bruges til rotation.

Nér deformationen er pé plads, dobbeltklikker
du pa billedet for at udfere den (Apply). Se et
eksempel side 31.

I stedet for at bruge héndtagene kan du
dobbeltklikke pé ikonet og indtaste talveerdier
for deformationen i en dialogboks.

7 Beskeering R

Q Forstgrrelse G

Med Zoom-varktejet kan du klikke pa et
billede med venstre museknap og opna en
forstorrelse, der er centreret omkring det punkt,
du klikker pa. Tilsvarende vil et hgjreklik
formindske billedet - i begge tilfeelde ét trin ad
gangen.

Som verktej til at beskeare et billede kan du
enten bruge det rektangulere selection-veerktoj
eller det specielle veerktaj Crop.

I begge tilfzelde kan du efter markeringen
taste Shift+R (Crop), men bruger du
beskaringsvarktejet, kan du ngjes med at
dobbeltklikke inden for markeringen.
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Crop-verktejet kan virke lidt
uprecist, fordi sigtekornet ligger
midt i markeren.

Til gengald har vaerktejet den fordel,
at du efterfolgende kan treekke i mar-
keringen pa samme made, som nar du
justerer sterrelsen pa et vindue.

& Lasso A

& Flytning \'}

Med Mover-verktejet kan du flytte et helt lag
eller blot omridset af en selection. Trekker du
med venstre museknap nede, er det hele laget,
der flyttes. Traekker du med hejre museknap
nede, er det omridset (marqueen), der flyttes.

Bemark, at vaerktojets marker
forestiller fire pile, der ikke nér
helt sammen pa midten.

Pilene ber ikke forveksles med
den marker, der angiver at
indholdet af en selection kan
flyttes.

i [selectior] Regelmaessigt areal S

Med Selection-verktgjet kan du markere et
regelmaessigt areal.

Pa Control-panelet kan du velge mellem
rektangel, kvadrat, oval og cirkel. Mens
markeringen af de firkantede arealer starter fra
hjernet, starter de runde fra midten.

Kig altid efter, hvilken verdi du har sat for
Feather pa Control-panelet. En pracis
selection kraever Feather = 0.

Sé leenge du har Selection-veark-
tojet aktiveret, vil markeren skifte
udseende til en flytte-pil, nir den
er inden for det markerede areal.

Flytter du derneest arealet ved at treekke i det
med musen, geres det flydende (floating) og
efterlader et hul i baggrunden (cuf). Holder du
Alt-tasten nede, mens du treekker, gares arealet
flydende uden at efterlade et hul i baggrunden
(copy). Nar den flydende selection er pa plads,
placeres den atter pa baggrunden med et
hgjreklik - eller ved at veelge defloat Shift+Ctrl
+F.

Freehand-varktejet, der bruges til at markere
uregelmassige arealer, har flere
underafdelinger pa Control-panelet: Freehand,
Point to Point og Smart Edge (beskrevet pa
side 28).

Freehand (ogsé kaldet Lasso) er meget
velegnet, nér du skal arbejde med en bestemt
del af et billede. Nar arealet er indkredset, vil
storstedelen af maleverktajerne og filtrene kun
virke inden for det afmarkede omrade og sikre
en pracis bearbejdning.

Du tegner med lassoen ved at bevage
markeren, mens du konstant holder venstre
museknap nede. Nar du slipper knappen,
forbindes forste og sidste punkt pa kurven med
en ret linje.

Efterfolgende kan du @&ndre markeringen
ved enten at tilfeje eller fratreekke et areal.

Holder du Shift-
tasten nede,
mens du tegner
et nyt areal,
forsynes
markeren med et
plus,

og du kan lave en filfojelse til den eksisterende
markering. Arealerne behever ikke at overlappe
hinanden, og metoden kan anvendes pa alle
selection-veerktejerne i fleng.

Holder du i
stedet Ctrl-
tasten nede,
forsynes
markeren med
et minus.

P& denne made kan du tilsvarende gore et
indhug 1 den eksisterende markering.

Les mere om selections side 26.
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& Areal ifglge farve M

& Malerpensel B

Tryllestaven Magic Wand bruges til at udpege
et areal med nogenlunde ensartet indhold af
farve. Pa Control-panelet kan du veelge, hvor
store forskelle i farve, du vil acceptere som
herende til samme markering. En lille
Tolerance medtager kun meget beslagtede
farver, mens en stor verdi fAr markeringen til at
brede sig over et storre omrade. Verdien skal
ligge mellem O (medtag intet) og 200 (medtag
alt).

Tolerance

|1EIEI 3:

# [Dieppe]  Aflaesning af farve Y

Dropper-varktgjet forestiller en pipette, der
kan hente en drabe farve, dvs. aflaese den
pagaldende pixe

L;—}_

Forgrundsfarve
Baggrundsfarve

Mens du beveaeger
pipetten henover

L

i

billedet (uden at
' & s klikke), kan du nederst
& B 13 pa farvepanelet
i 0 100

lebende studere den
aktuelle farves ud-
seende og talverdier.

Klikker du med venstre museknap, indszttes
den aktuelle farve som forgrundsfarve. Et
hgjreklik indsetter den som baggrundsfarve.

I gvrigt kan du nemt
I;F tl—}_'—Ii bytte rundt pa for- og

’3%2 baggrundsfarven ved at
B2t |

klikke pa skifte-pilen.
Pipetten er god at have ved hadnden, néar du
bruger et af de folgende pensel-verktajer. Af
samme grund er pipetten indbygget i penslerne,
sa du ikke skal klikke pa Dropper-varktojet i
tide og utide. Du kan midlertidigt forvandle din
pensel til pipette ved at holde Ctrl-tasten nede,
mens du maler.

| R2ss |

Paint Brushes byder pa en reekke pensler til at
male med. Penslernes egenskaber er faelles for
de 6 verktajer: Paint Brushes, Clone Brush,
Replacer, Retouch, Eraser og Airbrush.

P4 Control-panelet
kan du velge at
male pé papir, der
er praeget i
forskellige menstre
(textures), f.eks.

Controls
Tool Controlz I Brush Tipl

Faper testure

MHaone LI

Sidewalk, - '

Marble Fruit Peel, der

Parchrment minder om

EanstructiDEgaper - overﬂgden pa en
appelsin.

Prov dig frem!

De enkelte penselstrog kan du justere under
Brush Tip pa samme panel:

Shape er

Tool Controlz  Brush Tip | formen pa
penslen.
Shape .
M Size er d.ens
. I Round :I' storrelse i
Size pixels.
' - — |32 Opacity er
Opacity Hardness gar&ns
| |_ I_ xkkeevne
J = . angivet i
VEED Sz procent.
J oo —F— 5 || 100%
betyder totalt
dekkende.

100% Hardness giver et pracist afgreenset
penselstrag - lavere vaerdier bladger kanten.
100% Density giver et massivt strog, lavere
veerdier vil klatte lidt med farvepunkterne (som
en svamp). Step far penslen til at hoppe. Er
verdien f.eks. 25, bliver afstanden mellem de
enkelte hop 25% af penslens storrelse.

Ud fra bestemte vardier for Opacity, Hard-
ness og Density er der sammensat en raekke
skreeddersyede penseltyper, f.ecks. Pen, Pencil
eller Marker, som du kan

velge ved at klikke pé - X
knappen med Brush Brush Options
Options.
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v Marmal Selv om starstedelen
af de preefabrikerede
Ml penseltyper ikke har
_ andet at byde pa, end
Friiis hvad du selv kan
Fen eksperimentere dig
Fencil frem til, far du med
bdarker Custom Brush
Crayon mulighed for at male
Chalk med ferdige figurer -
lidt efter samme
Charcoal princip som Picture

Tube.

Custom Brush

Clane maode

Aligred - I

Onsker du at vende tilbage
til det forst valgte
kildepunkt, hver gang du
starter pa et nyt penselstrog,
skal du veelge Non-
aligned.

Kloner du med en nedsat dekkeevne, f.eks.
Opacity 50%, bliver overgangen til de
oprindelige farver mere jaevn. Til sarte
reparationer kan du velge 20% og male ovenpa
flere gange.

For at beskytte omgivelserne kan du selecte
det aktuelle omrade, som dine penselstreg nu
vil holde sig inden for. Din selection vil ikke
begranse kildepunktets aflaesning, som endog
kan foretages fra et andet billede, du har &bent.
Prov selv!

Bz Farveskift ,

7 Maling efter kopi N

Clone Brush er et formidabelt vaerktgj til at
reparere sma uregelmassigheder i et billede.
Penslen henter hele tiden sin farve fra et andet
omrade af billedet - den sakaldte kilde, der har
samme sterrelse som den malende pensel.

Nar vaerktejet er valgt,
definerer du kildens
begyndelsespunkt med et
hajreklik. Dernest flytter
du penslen hen til det
sted, hvor du vil male.

Mens du maler, kan du
hele tiden se kildens
placering i form af et
kryds, der bevager sig i
en konstant retning og
afstand fra penslen.

Metoden, hvor kilde og
pensel hele tiden parallel-
forskydes med den samme
retning og afstand, kaldes
Aligned.

Clore mode

I.-'l'-.ligned - I

Color Replacer erstatter en farve med en
anden. De steder, hvor du maler med penslen,
vil baggrundsfarven blive skiftet ud med
forgrundsfarven. Har du valgt dette vaerktej og
dobbeltklikker pa billedet, vil alle forekomster
af baggrundsfarven blive erstattet af forgrunds-
farven (bruger du hegjre museknap, er det
omvendt). Jo hgjere Tolerance (max. 200) du
veaelger, des mere drastisk bliver udskiftningen.

[ Forskgnnelse V4

Med Retouch-penslen kan du male dig frem til
@ndringer af den eksisterende farve.

Du kan Lighten (lysne), [Wirnmn
Darken (merkne),
Soften (bladgere) og
Sharpen (skarpe) dine
farvepunkter. Emboss

T ool Contrals I

Fetouch mode

Lighten RGE I

giver et metalagtigt re- Datken BGE =

lief. Smudge tvearer Saften

farven ud, Push Sharpen
Emboss

skubber den fremad. Srmudge

Dodge lysner de morke Fush

omrader, mens Burn Dodge
Bum -

merkner de lyse
omrader.
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ed Viskelaeder E

e Spraydase U

Eraser bruges til at fjerne farve. Maling med
viskeladeret har samme virkning som at selecte
et areal og klippe det vaek med Ctrl+X.

Péa et almindeligt fladt billede (dvs. et billede
uden lag) erstatter viskelaederet den
eksisterende farve med baggrundsfarven.

Pé et lag erstattes farven af et transparent
(gennemsigtigt) omrade. Du lan laese mere om
lag pa side 37.

Punktum

Airbrush virker efter samme principper som
Paint Brushes, dog er penselstraget en smule
mere luftigt ved de samme Brush Tip-vardier.

& Udfyldning F

& Billeder pa tube

Picture Tube virker som en stempelmaskine,
der kan spytte smé billeder ud pa stribe.

Controls Tube
T ool Cantrols I I':DinS - I

Caoinz

Tube Letter Blocks :
II:-:uins - I Pointing Handz
Scale
— J_ Pa Control-panelet kan
. du vaelge mellem flere
100% . .
feerdiglavede serier af
Options... | billeder og bestemme

deres storrelse.

Velger du Coins
og maler med
penslen, udspys
en stribe
forskellige monter
henover dit
billede. Under
Options kan du
finjustere maden,
hvorpé de

enkelte monter skal dukke op.

Hos www.jasc.com pa Internettet kan du hente
flere varianter af Picture Tubes som filer med
efternavnet tub.

Vil du udfylde en selection, vaelger du Flood
Fill og klikker indenfor omradet. Et normalt
klik udfylder med forgrundsfarven, et hgjreklik
med baggrundsfarven.

Controls

Tool Controlz I Brush Tipl

Udfyldningen kan
forega i forskellige
mgenstre, Styles,

Fill Style der kan veaelges pa
Salid Color | Control-panelet.
Fattern Ved at klikke pa
Linear Gradient Options kan du

Rectangular Gradient

Sunburst Gradient f.eks. lave en

Rl adial Gradient detaljeret overgang
mellem for- og
baggrundsfarve i en

Optionz |
sakaldt Gradient.
Flood Fill Options K|

Fill Shyle; ILinear radient ;I

Blend Maode: I Marmal - I

Direction:

l

IEI Degres
k. I

-
4

A d

Cancel |

Gradient findes i flere udgaver.
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A Tekst X

/ Streger I

Nar du klikker pa billedet med Text-varktojet,
dukker en sarlig dialogboks op, hvor du kan
veelge skrifttype og -sterrelse (prov dig frem)
samt en rude til at skrive selve teksten i.

Add Text |
— Faont attributes — T ext effects—
M ame: [T Strikeout
Times Mew Raman W L

Sustem - R
V¥ antizlias
Verdana
% ﬁﬁhlﬂ_ﬂgs j — Alignment
ingdings & Leit
Sample at 1:1 zoom: ¢ Center
Mong “*
¥ Floating

Enter text here:
IM ana

Cancel Help
N

Normal

Laeg merke til
effekten Antialias,
der udjaevner
tekstens omrids ved
at inddrage den
bag-

vedliggende farve.

Antialias

Har du aktiveret Floating,
vil et klik pd OK fa
teksten til at dukke op
med samme farve som
forgrundsfarven som en
== floating selection.

Sa lenge du ser
flyttepilen med sine fire
arme, er teksten er frit
bevegelig. Forst efter et
hajreklik bliver teksten en
permanent del af billedet.

Laes mere om tekst pa side 36.

En lige streg tegnes med Line-verktejet. Du
placerer markeren pa startpunktet og holder
museknappen nede, indtil du har naet
endepunktet. Stregens farve bliver
forgrundsfarven med venstre museknap og
baggrundsfarven ved brug af hgjre museknap.

Holder du Shift-tasten nede, mens du
treekker, begranses stregens retning til vandret,
lodret eller 45°.

Velger du Bezier pa Control-panelet, kan
du forme stregen som en kurve:

Det forste treek udfores .
som normalt og T
resulterer i en tynd linje

mellem start- og

endepunkt.

Et efterfolgende klik og —+
treek vil nu forst krumme /A\
linjen med

udgangspunkt i
startpunktet.

Det naste klik og traek
vil derneest krumme T -
linjen med _i:i
udgangspunkt i

endepunktet.

Til sidst vil kurven blive

vist med den valgte
tykkelse og farve.

e

m Figurer /

Med Shapes kan du tegne rektangel/kvadrat
og ellipse/cirkel enten udfyldt (Filled) eller som
omrids (Outline).

Figurerne tegnes efter samme
princip som en regelmaessig

selection: de firkantede vokser

ud fra et hjernepunkt.

Omvendt vil de runde figurer
vokse ud fra et centrum, nar du
klikker og treekker.
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Abn et billede

Nar du har abnet et billede med kommandoen File Open, husker PSP, i hvilken mappe du har hentet
billedet. Naeste gang, du vil dbne et billede, er det indholdet af denne mappe, der forst vises.

% Paint Shop Pro
=W Edit  iew

Opener et af de
gverste punkter i
menuen File. Her kan

e, . Ctrl+M o
Open... o Cirl+0 du samtldlg sc, at
= funktionen har
Close genvejen Ctrl+O pé
1 Coxjpg tastaturet: du holder

. Ctrl-tasten nede, mens
2 FE[NEF.tIf. du taster bogstavet O.
4 Camelotjpg Nederst i menuen File
4 Familie.gif kan du se (og klikke

_ pa) navnene pa de sidst

ol abnede billeder.

¥ Paint Shop
File Edit % findes endvidere blandt

Funktionen File Open

= knapperne pa den sakaldte
J.| B CE Toolbar lige under
&

menuoverskrifterne.
I alle tilfaelde er resultatet, at du ser indholdet af
den mappe, hvor du sidst hentede et billede:
Open |
Segr I ‘a Grafik. - I ﬁl

" Amalie.jpg 8] Familie. gif
Apple.brip E; Farer tif
E Camelat.jpg E; kona.jpg

@ Fanitar. gif

Filaer: IEn:n-:.ipg Abn

Filtype: I.-'i‘-.II Filez "’I Annuller |

Hyvis du klikker pé den trekantede pil ved ruden
Filtype, kan du veelge kun at se filer med et
bestemt efternavn. Listen viser, hvor mange
filtyper PSP understotter (lees mere om
billedtyper side 47).

Du abner filen ved enten at dobbeltklikke pa
dens navn eller ved at markere navnet og
dernzest klikke pa knappen Abn.

Onsker du at abne mere end én fil fra mappen,
kan du markere dem samlet ved at holde Ctrl-
tasten nede, mens du klikker pa dem enkeltvis.
Rakken af navne dukker op i ruden Filnavn:

E Amalie.jpg
.-“-‘-.pple.l:ump
E Camelat.jpg .
. @ b oyt if

Filbianer: I"I:u:u:-:. ipa’'Fary Abn

Tilsvarende kan du markere en rakke filer, der
ligger lige efter hinanden, ved at markere den
forste i rekken og holde Shift-tasten nede,
mens du klikker pa den sidste i reekken.

Dialogboksen Open kan i gvrigt bruges til
almindelig filh&ndtering: en markeret fil
omdpbes med F2 og slettes med Delete.

Har du markeret et enkelt billede, og er der
nederst i dialogboksen sat hak ud for Show
Preview, ser du en miniature af billedet:

— Image information / Presview
Width: 740
Height: 536
24 Bits Per Pixel
[1& Million Colors]

Dietailz.... [ |

¥ Show Preview

Eruwse[ |

Et klik pa Details
giver udferlige
oplysninger om
billedet, som kan
veere nyttige, nar du
vil g& i dybden.

JPEG - JFIF Compliant
Comprezsion: Huffman

" Image format

Image characteristics —
Dimensions: 740 » 536

Klikker du pa Browse, far du vist mappen i det
medfelgende albumprogram (se side 53).
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Filtyper

Nar du dobeltklikker pé et billede i
albumprogrammet PSP Browser, vil det altid
blive abnet i PSP. Det samme er ikke tilfeeldet i
et normalt mappevindue (Explorer). Her kan du
ikke pa forhand vare sikker pa, om et
dobbeltklik vil dbne billedet i PSP eller i et
andet grafikprogram. Det athaenger af, hvilket
program den pageldende filtype er associeret
til.

Har du flere grafikprogrammer installeret,
kan du risikere, at de uden dit vidende har
udrébt sig selv som det foretrukne program til
bestemte filtyper. Stoder du péd en sddan filtype
og ensker den associeret med f.eks. PSP, kan
det nemt lade sig gore.

Du markerer én af de filer, hvis efternavn du
vil associere, og klikker dernast pé filen med
hajre museknap, mens Shift-tasten holdes nede.

[CECamelat. jpg Shift + hejreklik
8] Fanmilie.c frembringer en

B Farve tif Abn med.. lille menu.
Gemsomr Her veelger du

Gobboj Owerartil  » | menupunktet
Horuz.dr

| Abn med...

8 Info.gr BP

Det nzste, du ser, er boksen Abn med, hvor du
blandt dine installerede programmer kan vaelge
det, den aktuelle fil skal abnes med:

HE|

Klik pa det program, du skal bruge
il at bne filen Camelat.jpg.

Abn med

NETSCAPE B
{F)NOTERAD

gﬁﬁ}ﬁ PAD j

¥ Erug altid dette program Gl at
abne filer med dette filtlypenayn

DKE I Annuller |

Setter du et hak i ruden Brug altid dette
program.., vil associationen (sammenheangen
mellem denne filtype og dette program) blive
lagret permanent i Windows.

Overfor til

Alt efter forméalet bruger jeg selv forskellige
programmer til at 4bne det samme billede, f.eks.
kigger jeg ofte pa et animeret billede via min
internet-browser. Af denne grund har jeg
placeret mine mest anvendte programmer pa
hejreklik-menuen Overfor til.., sa jeg hurtigt
kan &bne et billede efter eget valg.

For at fa et program til at dukke op pé
hgjreklik-menuen Overfar til.. skal du anbringe
en genvej til programmet i mappen Send To,
som er en undermappe til din Windows-mappe.

Nar du herefter i et Explorer-vindue
hgjreklikker pé en fil, kan du lynhurtigt
overfere den til (dvs. 4bne den med) det
onskede program:

Abn =4 3.5"-diskette (A)
YT @& Internet Explorer
Klip i Metscape
Kapier &) Notepad
Egenskaber

fl WehExpress3

Twain

Har du en scanner sluttet til computeren, kan du
via Twain (et modul, der forbinder ydre
enheder med dit grafikprogram) hente et billede
fra scannervinduet direkte ind i PSP:

% Paint Shop Pro
Edit “iew Capture Help

[ew... Ty H,F_QIEW| K?

Open...

ThWhAIN ¢

Export ¥ Camera »  Select Source..,

Exit Flug-in |

Acquire.. betyder at skaffe et billede. Med
Select Source kan du indstille, hvilken af dine
drivere, der skal anvendes som standard.

For at virke skal den pagaldende driver
befinde sig i mappen Twain, der er en
undermappe til din Windows-mappe.
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Andring af billede

Ved hjelp af programmets menuer er det forholdvis nemt at dreje, beskere og indramme et billede.

Du starter med at dbne billedet Cox.jpg.

Prov forst at finde
en passende
forsterrelse til
billedet med
tasterne [+] [=]
leengst til hgjre pa
tastaturet.

Du skal venne dig til altid at bruge sa stor en
del af skeermen som muligt, selv om dette
forholdsvis store billede pd 740 x 536 pixels
fylder godt pa skeermen i 1:1. Kig pa billedets
egenskaber ved at taste Shift+l (Information).

Nu skal du preve at se billedet uden
forstyrrende omgivelser i Full Screen
Preview. Du taster Shift+Ctrl+A (holder
tasterne Shift og Ctrl nede samtidig, mens du
trykker pa A). For at komme tilbage til
arbejdsvinduet trykker du pé en vilkarlig tast,
f.eks. den store mellemrumstast.

En lille advarsel her: Der findes en lignende
Full Screen-mulighed ved navn Edit, hvor du
kan bearbejde dit billede uden at se titel- og
menubjalken gverst pd skermen. Genvejen til
denne indstilling er Shift+A, men du kan kun
komme tilbage ved igen at taste Shift+A.
Kommer du til at veelge Full Screen Edit af
vanvare (og har glemt hvordan du kommer til-
bage), risikerer du at blive haengende. Du kan
ikke engang afslutte programmet normalt og ma
genstarte computeren med Ctrl+Alt+Delete.

Rotation

I mange tilfzelde har du brug for at vende et
billede 90° - fra langformat til hgjformat.

Du finder Rotate pa
menuen Image.

BN Colars

Elig Crl+| ! i

Mirrar YRy Bid merke 1 de

— — tilherende genveje for
_________ k Cirl+FR en anden gangs skyld.

Flip vil sige at vende billedet pa hovedet, mens
Mirror er spejling (hgjre-venstre-ombytning).

De tre prikker efter ordet Rotate i menuen
fortaeller, at der vil dukke en dialogboks op:

Rotate |
Diirection Degrees
& Right & 90 ¢ 180 & 270

" Left ™ Free: I
] |~_\ I Cancel | Help |

Right betyder 'med uret', Left 'mod uret'.
I ruden Free kan du angive et antal grader med
to decimaler.

Prov at rotere billedet Right 90° og fortryd
derneest ved at taste Ctrl+Z.

Crop

Et billede, der kommer lige fra scanner eller
kamera, vil ofte have brug for en beskcering. Du
veelger selv, om du vil fastlegge det nye
(rektangulere) omrids med Selection- eller
Crop-verktgjet. Nar du har tegnet omridset,
kan du i begge tilfeelde velge Image—>Crop
eller blot taste Shift+R.

Selection-vearktgjet er umiddelbart det mest
enkle at bruge (husk pa Control-panelet at
vaelge Rectangle med Feather 0).

Dels er vaerktojets sigtekorn et
precist kryds, som ger det nemt
at placere omridset..

..dels har omridset form som en
tydelig, punkteret marquee, der
blinker pa samme made som en
lysreklame i Las Vegas.

Ulempen er, at marqueen er sver at justere, nar
den forst er tegnet. Er du utilfreds med
storrelsen, mé du tegne en ny. Har den nye
marquee startpunkt inden for den eksisterende,
ma du forst annullere denne ved at taste Ctrl+D.
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Crop-varktejets sigtekorn
sidder i midten af ikonets
firkant, hvilket gor det mindre
praecist.

Desuden er omridset en streg,
som kan vere svar at fi gje pa.
Til gengaeld kan omridset
justeres ngjagtigt med sine sma
pile.

Prov nu at beskare Cox.jpg til en enkelt blomst
ved hjelp af Selection-varktejet. Fortryd din
beskaring med Ctrl+Z og prev igen, indtil du er
tilfreds med resultatet.

Besker dernest Cox.jpg til en enkelt blomst
med Crop-vearktajet.

Denne gang laver du med pilene
rigelig luft omkring blomsten, s
den kan praesentere sig pent
som et selvstendigt billede.

Border

Du skal nu lave en ramme rundt om billedet.

%

..hvorefter du klikker pa hgjre
museknap. Farven hentes nu ind
som baggrundsfarve, som er den

Med spidsen af Dropper peger du pa
en lys, blalig farve pa et kronblad..

-

farve, rammen vil fa. e
Pa den nederste del af farvepanelet DB igg
A

kan du se resultatet.
Forgrundsfarven (i dette tilfeelde
hvid) er her uden betydning.

Nu vaelger du Image
—>Add Borders..

I boksen angiver du
Symmetric og
skriver tallet 5.

Add Borders

Border zize
¥ Symmetric

Top: |5| 3:

Nar rammen skal veere symmetrisk, vil tallene
for Top, Bottom, Left og Right folges ad.

Nar du klikker pa OK, laves
rammen med en tykkelse pa 5,
der vil forege billedets starrelse
med 10 pixels pa hver led.

NB: Pé naeste side skal du gemme dette billede.

Undo

Programmet holder styr pa
dine handlinger, s& du kan
fortryde mange trin baglans.
Udover genvejen Ctrl+Z kan
du bruge knappen Undo til at
fortryde din sidste handling.

Blomst2.jpg

Image Colo
2| % By §

Hvis du gentagne gange taster Ctrl+Z eller
klikker pa Undo-knappen, rykker du hver gang
et trin baglaens i dine handlinger. En liste over
dine handlinger findes i en Undo History, som
du kan se under menuen Edit eller ved at taste
Ctrl+Shift+Z:

Undo History | Hver
Select the action(z] to undo: handling
Mum Time Since  Achion har et

K] 0. 03 Add Border nummer,

2 00:02  Crop som du kan

1 oo:23 MNew Selection markere.
Klikker du

Undo Cancel | o

derneest pa
Undo, vil
denne og

alle de foregdende handlinger (dvs. med lavere
nummer) blive annulleret pa én gang.

I version 6 hedder den samme funktion
Command History.

For at det ikke skal vare logn, kan du endog
fortryde den sidste Undo med Redo, der
udferes ved at taste Ctrl+Alt+Z.

[l “iew Image Colors Bade Undo
Undo Add Border Cirl+Z og Redo
Bedo W CirlsAftsz | findes

. under Edit.
Undo Histony... Shit+Cirl+Z

Der er en ekstra gevinst ved at bruge
menupunktet under Edit: det indeholder altid en
beskrivelse af din sidste handling.

IRl Edit  “iew Sluttelig skal naevnes
Mew  Cirl+M kommandoen Revert,
Cirl+0 der mdebaerer, gt du
vender tilbage til det
Browse... Litl-B oprindelige billede,
Close som det s& ud, da du
sidst abnede det.
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Gem et billede

Mens du arbejder med et billede, opbevares alle dine @ndringer i computerens flygtige hukommelse,
dens RAM, som har en begraenset storrelse og er sirbar overfor stremsvigt. Forst nir du gemmer
billedet ved at overfore det til din harddisk, er det pa betryggende vis sikret for eftertiden..

Som tommelfingerregel skal du regne med, at
det kraever op til tre gange sa meget RAM at ar-
bejde med et billede (redigere det), som det
kraever at vise det pa skeermen. Det skyldes
bl.a., at programmet bade skal huske det
originale billede og de @ndringer, du laver
henad vejen.

Nér du taster Shift+l for Image Infarmatian I
Image Information, kan —FAM Used
du nederst pa fanebladet Image:  1162K
aflaese, hvor meget RAM Selection:  OE
det aktuelle billede legger b ks K.
beslag pé. Unda: 14
Tallet vil stige i takt med Total 162K
dine andringer.

De 1162 kilobytes (forkortes til KB eller K),
som billedet i dette eksempel fylder i RAM,
hidrerer fra Cox.jpg, der pa harddisken kun
fylder 78 KB. Billeder med efternavnet JPG er
nemlig steerkt komprimerede - 1 dette tilfelde
nesten 15 gange.

Konklusionen er, at billedbehandling kan
vaere ret RAM-kravende. Ganske vist kan du
ikke mindske RAM-forbruget for det
oprindelige billede, men ved at gemme det med
jevne mellemrum kan du nulstille det forbrug,
som dine @ndringer kraever. For at forhindre, at
du pé et tidspunkt leber teor for hukommelse er
det derfor en god idé at gemme billedet med
jevne mellemrum.

P4 titelbjeelken kan du altid se, om billedet
er jomfrueligt eller ej. S& snart du foretager din
forste &endring (i forhold til den fil, som ligger
gemt pa harddisken), dukker en stjerne op efter
billedets navn:

Uaendret: E Cux.jpg AEndret: Eq Cux_jpgt

Hovedreglen lyder: Har et billede gennem et
stykke tid haft en stjerne pa sin titelbjelke, kan
du godt forberede dig pa at gemme det.

Nu skal du preve at gemme det
indrammede billede af blomsten,
som du lavede pa forrige side.

Pa titelbjeelken hedder billedet stadig Cox.jpg,
men for ikke at gemme blomsten oven i det
oprindelige billede (som derved ville blive
slettet) giver du billedet et nyt navn undervejs.
Du trykker pa tasten F12 (Save As) og skriver
Blomst i ruden Filnavn:

Save Asg |
Seqi I'a Grafik, vI il
% Coxjng

E tona.jpg

Filnaw: IBIDmst.ipg Germ
FllL','I:IE IJPEG - JFIF "I Aaanller |

Da du gemmer et billede, der er lavet pa grund-
lag af Cox.jpg, vil den nederste rude, Filtype,
automatisk veere indstillet pa efternavnet JPG.
Sé snart du har klikket pad knappen Gem,
overfores billedet til din harddisk.

Gemmer du derimod et nyt billede, vil
programmet foresla dig at bruge sit eget
standard-format med efternavnet PSP:

Filnawr:

Filtype: IF"aintShu:up Fro lmage [“.psp];l

Du kan laeese mere om de forskellige formater
(billedtyper) pa side 47.

Arbejder du videre med Blomst.jpg og
senere gnsker at gemme de nye @ndringer, skal
du taste Ctrl+S (Save). Herved opretholdes det
eksisterende navn (du ser ingen dialogboks) og
den oprindelige fil med samme navn erstattes af
den nye.
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Billedets storrelse

Da den digitale verden er s& anderledes end den fysiske verden, vi er fortrolige med, kan det vere lidt
af en videnskab at ndre sterrelsen pa et billede. Det handler om at teenke i billedpunkter, i pixels.

Lad os starte i den lette ende med at udvide
billedet med et hvidt stykke i hgjre side. Du kan
f.eks. have brug for at skrive en tekst eller
indsette en stump fra et andet billede.

Nér du pa denne
made fojer et
areal til billedet,
kaldes det at
endre sterrelsen
pa leerredet.

P4 engelsk hedder kommandoen Canvas Size.
Du skal nu prove at tilfoje et stykke hvidt
leerred, som har en bredde pa 100 pixels.

[

E-1z0 E 255

Farven pa det nye stykke
leerred bliver
baggrundsfarven, som du
serger for at gere hvid.

Canvas Size
Start med at veelge Image—>Canvas Size..

Change Canvas Size |

I de gverste
ruder skriver

— Dimenzions du det
. u det nye
New Width: ]340 antal pixels.
Mew Height:  [5ag5 = Den
Cumentwidty, 740 oprindelige
Current Height: 536 bredde var
740 og skal nu
—Image Placement @ndres til 840.

Right: |1 oo E: Under

Placement ..
OF. ; I Cancel | Right (den nye
i hgjre margen)
skriver du
100.

Nar du klikker pa OK, tilfgjes det nye stykke.
Du gemmer resultatet som Cox2.jpg.

Dernest lukker du billedet ved at M= E3
klikke pa lukkeknappen gverst til 3
hgjre i vinduet.

Resize

Den tilsyneladende enkle proces at skalere et
billede, dvs. at &ndre sterrelse uden at lave om
pé forholdet mellem bredde og hejde (billedets
proportioner), kraver et indgreb i den samlede
mengde pixels. For at lave et storre billede skal
der tilfajes nye pixels - for at lave et mindre
billede skal der fjernes pixels.

Prov nu at skalere Cox.jpg til en fjerdedel
starrelse, altsa til 25%, pa hver led.

—l Du abner billedet ved at
m klikke pa Cox.jpg forneden
2 CoxZ jpg p4 menuen File.
Dernast velger du Resize
fra Image-menuen.
I boksen Resize kan du angive den nye
storrelse enten som pixels eller som procent af
det oprindelige billede. Den mulighed, du ikke
bruger, ses i gratonet udgave. Hvis du veelger
Percentage og skriver 100%, kan du se
billedets oprindelige sterrelse, hvilket kan vere
en hjelp, nér du vil arbejde med pixel-verdier:

Exit

Hesize |
—i" Pisel Size

“afidth |?4EI 3: % Height IESE 3:

—{* Peicentage of Original

widh [100 =] « Height [100 =

Nu @ndrer du sterrelsen til 25% pé hver led:

Resize K

—i" Pisel Size

“afidth I'IBE 3: % Height |134 3:

—{* Peicentage of Original

Widh [25 =  Height [5 =
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Efter at have angivet storrelsen skal du tage
stilling til den metode, Resize Type, du vil
anvende:

Resize Type |Smart size -

Bilinear rezample
¥ Resize 4l | Bicubic rezample
Layers Pizel resize

¥ Maintain aspect ratio of I'I,EEEIEEIT-" to 1

De viste muligheder kreever en forklaring.

Forestil dig de enkelte pixels i det
billede, som skal skaleres.

En skalering til 200% (pa
hver led) kan foretages ved at
erstatte hver pixel med fire
nye af samme slags.

Skalering til 50% (pa hver led) sker ved at
erstatte hver fire pixels med en enkelt ny.

Denne metode, der kaldes Pixel Resize, egner
sig bedst til billeder med praecise former og
skarpe kanter - f.eks. diagrammer og logoer.

Til fotografiske billeder, hvor bade farver og
former er mere komplekse, er det en fordel at
anvende den mere omfattende Resample.

Bedst egnet til formindskelse er Bilinear
Resample, der i al sin enkelhed udregner
gennemsnitlige veerdier.

Bedst egnet til forstorrelse er den mere
avancerede Bicubic Resample, der getter sig
frem til nye pixels ved hjelp af interpolation.

Heldigvis kan du vaelge Smart Size, der
automatisk veelger den bedst egnede metode til
den aktuelle opgave.

¥ Maintain aspect ratio of I'I,EEEIEEIT-" to 1

Maintain aspect ratio betyder 'oprethold
billedets proportioner', og tallet viser forholdet
mellem bredde og hejde.

Canicel | Help |

Eg'ij Nér du klikker pa OK, formindskes
S Dilledet til 25% pa hver led.

Print Size

Midt i boksen kan du velge den 'faktiske'
starrelse, Actual Size, pa det feerdige billede.
Disse tal har ingen indflydelse pd dine pixels,
men fortaeller programmet, med hvilken feethed
billedpunkterne skal anbringes, nar de pa et
senere tidspunkt skal udprintes.

Her er tallene for det oprindelige Cox.jpg:

& Actual / Print Size

width |2Ei,1 0E
Height |1 2.9039

Besalution I-_"'E

cm e

|Pissls 2inch |

Hele hemmeligheden findes bag det lille tal i
ruden Resolution, som er et mél for den
omtalte tethed.

Da billedets resolution udtrykkes i pixels pr.
inch (ppi eller dpi), ser du som udgangspunkt
ogsé bredde og hgjde i inch, hvilket du kan
@ndre til cm ved at klikke pé den trekantede pil.
Du ser nu, at det oprindelige billede med en
resolution pa 72 ppi maler omkring 26 x 19 cm,
altsa knap en A4-side.

72 ppi er netop den resolution, som billedet
optraeder med pa skeermen. Din printer vil
imidlertid veere i stand til at gengive
billedpunkterne med sterre taethed, typisk 600
dpi (dots pr. inch), hvilket giver det samme
antal pixels en fysisk udstreekning pé 3,1 x 2,3
cm.

I forhold til billedet, som det ses i fuld
storrelse pa skermen, vil det udprintede billede
derfor veere ca. 8 gange mindre pa hver led.

Nar du arbejder med et billede, skal du ferst
og fremmest teenke 1 pixels. Du opndr den
bedste kvalitet ved at bevare antallet af
pixels, dvs. hvis du kan undgé Resize.

Er du nedt til at reducere antallet af pixels
(sample down), sker der kun en mindre
forringelse af kvaliteten. Vil du derimod
forage pixelmangden (sample up),
nedsattes kvaliteten merkbart. Derfor er
det en fordel at starte med sa mange pixels
som muligt.
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Farver

Farvestandarden for de fotografiske billeder, du kan bearbejde i PSP, hedder 24 bit RGB.
24 bit svarer til 16 millioner farver, som er det antal, det menneskelige gje kan skelne fra hinanden.
RGB er en forkortelse for skaermens tre grundfarver: red, gron og bla

Antallet af farver i et billede (den sékaldte
farvedybde) angives som regel i spring:

[Bit [Potens [Antal |

4 2¢ 16
g8 28 256
24 2* 16 mio.

Fordelen ved en lav farvedybde er, at billedet
optager mindre plads pa harddisken og f.eks. er
hurtigere at overfere via internettet. Alt andet
lige vil et 8 bit farvebillede kun fylde en
trediedel af et tilsvarende med 24 bit farver.

I realiteten er besparelsen imidlertid ikke sa
stor, fordi farverne i mange tilfzelde kan
komprimeres. Det er bl.a. tilfeldet med
filformatet JPG, hvor et stort antal farver
skreelles vaek, nar billedet gemmes.

Nér det overhovedet er aktuelt med en
farvedybde pa kun 8 bit, skyldes det
hovedsagelig, at en del populere filformater,
bl.a. GIF, kun kan rumme 256 farver. Las mere
om disse billedtyper pa side 47.

En stor del af de funktioner, der findes i
PSP, forudsatter en farvedybde pé 24 bit.

Har billedet en lavere Euttonize. .

farvedybde, vil Chisel

funktionerne vare sat ud ~
Cutout...

af kraft, og du ser

menupunkterne i en Drop Shadaw...

gratonet udgave.

For at kunne benytte funktionerne skal du ege
farvedybden til 24 bit. Du kan altid senere ga
tilbage til den oprindelige farvedybde.

Color Depth

Forogelse af farvedybden sker ved at vaelge
Colors—>Increase Color Depth
Decrease ColorDepth » 16 Colors
Increase Color Depth b » EEEREYITE
16 Mio. Colors

Hvad enten du valger Increase (ger storre)
eller Decrease (gor mindre), ser du kun de
vaerdier, som er mulige - resten er gratonede.

Nar du anvender Decrease til at gore
farvedybden mindre, f.eks. til 256 farver, kan
det ske efter flere metoder:

Decrease Color Depth - 256 Colors |

Falette Reduction method
' [ptimized Median Cut % Mearest color

" Optimized Octree ™ Ordered dither
" Standard " Emor diffusion

k. E I Cancel Help

Farst skal du tage stilling til, hvilken palet de
256 farver skal indplaceres i. Bdde Optimized
Median Cut og Optimized Octree udregner
(med hver sin beregningsmetode) den optimale
fordeling af farverne for det aktuelle billede.

Standard serger for at medtage de 16
farver, der indgér 1 Windows' standard-palet.
Laes mere om paletter pa side 50.

Nar du velger Reduction method, kan du
med Nearest color beslutte, at hver ny farve
skal vaere den i paletten, der ligger teettest pa
den oprindelige.

En anden mulighed er at skabe
mellemtoner ved at blande palettens
farver i menstre - kaldet Dither. =

Ordered Dither, der kun er mulig med
paletten Standard, ger menstrene ekstra
tydelige.

Error Diffusion serger for en mere diskret
fordeling af menstrene med blandingsfarver.

Mens Decrease Color.. som regel
forringer billedets farver, vil Increase
Color.. overhovedet ikke pavirke deres
kvalitet.
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Color Picker

Nar du arbejder med et billede, har du hele
tiden to farver reserveret til serlige formal:
forgrundsfarven og baggrundsfarven. Som
tidligere naevnt kan de vaelges ved at venstre-
eller hejreklikke pa billedet med Dropper-
vaerktojet.

‘ Onsker du at redigere
forgrunds- eller
baggrunds-farven, kan du
klikke pa én af ruderne.

R 237

Programmet kan vere indstillet til at vise farve-
veaelger (Color Picker) enten efter PSP- eller
efter Windows-standard:

Color Farve

Baszic Colars Grundfarver:

E |

PSP standard Windows standard

Indstillingen kan @ndres under File->Prefe-
rences—>General Program Preferences
—>Dialogs and Palettes:

Paint Shop Pro Preferences

Mizcelaneous I Fulersz and Unitz | Cu
Dialogs and Falettes I Wiewing

r[%Llse standard “Windows color picker

Foruden de 48 grundfarver kan du i
farvevaelgeren handplukke en farve blandt det
samlede udvalg.

I Windows-udgaven kan du flytte et
sigtekorn rundt i et regnbue-farvet areal, og
med en lille trekantet pil veelge lysstyrke:

(4

I PSP-udgaven, der gennemgas i det folgende,
er regnbuen udformet som et hjul:

1: Farvens
placering i
hjulet
kaldes dens
Hue.

2:Inde i
midten kan
du velge
Saturation
0g
Lightness.

Den storste Saturation (mettethed) finder du
helt ude i hejre side af kvadratet. Den storste
Lightness (lysstyrke) finder du helt forneden.
Den aktuelle farves talvaerdier (som du i
gvrigt kan indtaste direkte i stedet for at kere
rundt med pipetten), er tal mellem 0 og 255:

— Curment Color
01d Calar

Bed: Iﬁ Hue: I?
Greer: IE Sat: Iﬁ . .
Blue: |1_ Light: Iﬁ

Palette

Er dit billede pé 256 farver (eller
mindre) kommer du ikke direkte til
farvehjulet ved at klikke pa
forgrunds- eller baggrunds-ruden.
For denne type billeder er farverne opstillet i en
palet (engelsk: palette), en farvelade med 256
nummererede pladser. I paletten vil den farve,
du har klikket pa, vaere fremhavet med en
ramme:

Color From Palette |. EEEEEN

‘ |:| Falette index: 249

R 237

Color; B:237,G:236,B: 247

Under paletten kan du aflese den aktuelle
farves (indeks) nummer 249 samt dens indhold
af Red, Green og Blue.

Vil du redigere farven i farvehjulet, kan du
vaelge Edit Palette med genvejen Shift+P.
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Adjust colors

Udover at veelge enkeltfarver til at male med
kan du justere farverne for hele billedet.

Prov nu at endre farvespektret (Hue) for
Cox.jpg. Du serger for, at billedet er dbnet og
at der ikke er lavet en selection pa det. Med
kommandoen Adjust colors kan du nemlig
ngjes med at justere farver indenfor en valgt
selection, men i dette tilfeelde skal det gaelde
hele billedet. At 'intet er valgt' (svarende til
Select None Ctrl+D) har i denne
sammenhang samme betydning, som hvis 'alt
er valgt' (Select All Ctrl+A).

Under Colors—>Adjust vaelger du punktet
Hue, Saturation, Lightness, der i gvrigt har
den direkte genvej Shift+H.

£} Cox.jpg [1:1] (Background)

Hue{SaturationfLightness

Zoom 11 | 4

W Auta Proof

()

I dialogboksen kan du frit &ndre Hue,
Saturation og Lightness for billedet. Boksen
er en fin illustration af, hvad de tre storrelser
betyder.

Ruden gverst til venstre viser et udsnit af det
oprindelige billede, mens ruden til hgjre viser
det samme udsnit efterhdnden som du foretager
@ndringer. Du kan lade udsnittet vare en sterre
eller mindre del af billedet ved at klikke pa en
af Zoom-knapperne [-] eller [+].

Velger du Auto Proof, kan du se de
lobende @ndringer pé det oprindelige billede.
Dine indstillinger bliver ferst gaeeldende, nar du
har klikket pa OK.

Veardierne angives i % som enten positive eller
negative tal, sdledes at bade -100 og +100
giver den oprindelige verdi (hele vejen rundt
den ene eller den anden vej). Nar du f.eks.
traekker skydeknappen til Hue fra midten (0 %)
lidt mod hgjre til 25%, forskydes alle farver en
kvart omgang 1 farvehjulets regnbue.

Klikker du nu pa OK, bliver de nye farver en
del af billedet (men kan dog fortrydes med
Ctrl+2).

Vender du tilbage til den samme dialogboks
ved atter at taste Shift+H, vil skydeknappen sta
pa samme verdi (25%), som da du sidst forlod
den. Det medforer, at billedets farver igen for-
skydes en kvart omgang - som en service, hvis
du vil foretage den samme proces flere gange.
Tallene skal altsa altid opfattes relativt - som en
@ndring i forhold til forrige handling. Veer
derfor opmerksom pa, om tallene faktisk star
pa 0, nér du starter.

Nar du har eksperimenteret med forskellige
verdier, klikker du OK til 25% forskydning af

Dette billede beskarer du
med Crop, s det kun
indeholder en enkelt blomst.
Tast F12 og gem resultatet
som Minirosa.jpg.

Som en ekstra
ovelse slar du en
lasso omkring
de gronne
stovdragere. Du
taster Shift+H
og forskyder
Hue til -25%,
sé de igen bliver
gule.

Du fjerner lassoens marquee
med Ctrl+D og slutter med at
taste Ctrl+S for at gemme
den forbedrede udgave af
Minirosa.jpg.
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Set transparency color

Til sma billeder p& en hjemmeside, kan det ofte
vere en fordel, at motivet ses pa en
gennemsigtig (transparent) baggrund. Nér du
arbejder med et 256 farvers billede, kan du
udneavne én af farverne til at optraede
transparent.

Nar du skal udnavne en transparent-farve, er
det en god id¢ at finde en steerk farve, der ikke
forekommer i billedet. Valger du en farve fra
billedet, vil der opsta gennemsigtige pletter de
steder, hvor farven forekommer. Og da farven i
den sidste ende skal vaere usynlig, er det en
fordel, at den er tydelig, sé lenge du arbejder
med den.

I denne gvelse skal du pa Minirosa.jpg daek-
ke alt uden om blomstens kronblade med en
steerk bla farve, som du senere gor transparent.
Du klikker pa ruden med forgrundsfarve (den,
du skal male med), og vaelger i farvehjulet en
klar bla ved at skrive O i ruderne Red og
Green, samt 255 i ruden Blue.

Nar du har
godkendt med
OK, kan du
begynde at male
med den bla
farve.

s

Gl =
A==

.

Zoom ind pa Minirosa.jpg (omkring 5:1), valg
Paint Brush og mal langs blomstens kronblade
med en penseltykkelse pa 3 pixels. Fortryd med
Ctrl+Z , hvis der kommer blét pa blomsten.

Nar kronbladene er
indrammet af blat, deekker du
den resterende del af billedet
med en bredere pensel

(f.eks. 10 pixels).

Da den transparente farve er nem at
definere ud fra baggrundsfarven,
klikker du pé skiftepilen, s& den bla
farve kommer til at ligge bagest.

Fra Colors-menuen velger du nu Set Palette
Transparency..

m Lawers Selections

Genvejen til

e o———— dctte punkt
-_-T. Falette Transparency.. hedder
v Wiew Palette Transparency ™ | gpift+Ctrl+V

Da billedet har mere end 256 farver, bliver du
forst opfordret til at senke farvedybden:

Faint Shop Fro b |
I order ko zet palette ranzparency
thiz image must be reduced to
1 background layver and 256 colors.
Whould you like bo dao this now?

Efter at du har klikket pa Ja, bliver billedet i
stand til at handtere den transparente farve:

Set Palette Transparency

N
5

o tranzparency

et to backaraund calor

&
etto palette entmy IG
aK r | Froof |

Onsker du at se transparensen, velger du View
Palette Transparency ved at taste Shift+V.

Den bla farve erstattes nu af
en ternet menster, hvilket er

" programmets made at vise
L }‘? gennemsigtighed pa.

Du gemmer nu Minirosa i formatet gif ved at
trykke pa F12 (Save As) . I ruden Filtype
veelger du: CompuServe.. (*.gif).

Fitwpe: |CompuServe [~.gif] v | Gem

Filen kommer altsa til at hedde Minirosa.gif.
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Pensler

De forskellige pensler kan langt mere end at smere farve pé billedet. Der er noget for enhver smag.

Du har allerede provet at male med den
almindelige pensel Paint Brush.

New Image
Width |2|:":|

Hvis du vil udforske
dette vaerktoj yderligere,
kan du med Ctrl+N &bne

Height I_EDD et nyt billede pé f.eks.
= 200 x 200 pixels med
Color IWhite - I hvid baggrund.

Serg for at have Control-panelet synligt
[ (kan skjules ved tryk pd Tab-knappen)

Controls [E4

Bruzh Tip

Du vealger en passende
forgrundsfarve og afprever
med Brush Tip forskellige
former, storrelser, =hape
dakkeevner og hirdheder. . IF"I'U”'Z|

Controls B4

Tool Contrals |

Undervejs kan du skifte type
pa dit papir, sa dine
penselstrag far varierende
struktur.

Et tryk pa Ctrl forvandler
penslen til Dropper-varktgjet.

Paper testure

I Fruit Peel

Clone Brush

Pa billedet Scratch.jpg skal du nu med Clone
Brush fjerne den vandrette, hvide streg, der
skal forestille en ridse fra et negativ. Du abner
billedet og zoomer med knappen L*| til 4:1.

Du selecter stre-
gen med tryllesta-
ven Magic Wand
Match: RGB
Tolerance: 20
Feather: 0

Nu vaelger du
Clone Brush
Size: 1
Opacity: 100
Hardness: 100
Density: 100
Step: 1

Du hgjreklikker én pixel over stregen og maler
dernast pa selve stregen. Clone Brush vil hele
tiden hente farven én pixel hejere oppe og over-
fore den til det hvide. Din selection vil
forhindre dig i at male ved siden af.

Mal i smé bidder
og slip venstre
museknap efter
hvert stykke. Det
gor det muligt for
dig at fortryde ét
stykke ad gangen.

Nér stregen er farvet, fjerner du din selection
med Ctrl+D.

Visse steder, bl.a.
ved gjenbrynene,
vil du kunne se en
uregelmeessighed,
som du selecter
med et rektangel
(3 pixels heijt).

Velg Retouch
Mode: Soften
Brush Tip:
Size: 10
Opacity: 50
Hardness: 50

Med den rigeligt
store pensel
bladger du
farvepunkterne i
din selection.
Gentag bled-
goringen ved det
andet gjenbryn.

Fordelen ved at lave rektanglet til bledgering 3
pixels hgjt er, at Soften-funktionen inddrager
nabo-pixels pa begge leder. Formélet med
bledgeringen er netop at udviske skellet mellem
den farvestribe, som Clone Brush har lavet, og
de pixels, der ligger over og under.
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Selection

At markere et udsnit pa et billede er en af de mest centrale funktioner. Arealet inden for markeringen
(den sdkaldte selection) kan dels fjernes, kopieres eller flyttes. Dels fungerer en selection som fokus
for dine @ndringer, sdledes at de udelukkende far virkning inden for det markerede areal.

For at finde ud af, hvordan en selection kan
opfore sig, starter du med at lave et rektangel.
Abn Mona.jpg og velg verktejet Selection

ved at trykke pa tasten S.
Da varktejet rummer flere Controls
muligheder, er du nedt til at Tool Controls |

kunne se Control-panelet.
Er det ikke synligt, trykker

Selection ype

du pa tasten O (ContrOl). IHectanEﬂE % I
Du valger Rectangle. Feather
Feather skal vare 0. 0 =

Antialias skal ikke veere
aktiveret med et hak.

[ Antialias

Nu anbringer du
markeren et sted pa
billedet og tegner et
rektangel.

Beveager du dernaest
markeren ind i din
selection, forvandles den
til en firesidet flyttepil.

Hvis du nu bevaeger
markeren, mens du holder
venstre museknap nede
(treekker i din selection),
vil den efterlade et hul!

Hullet, der altid vil fa& samme farve som
baggrundsfarven, er et udtryk for, at du har
klippet (Cut) din selection ud af billedet forud
for en flytning (Move).

Bliver du ved med at traekke, vil flytningen
fortsaette. Din selection er frit beveegelig - den
er flydende (Floating) - hvilket du samtidig kan
se pa titelbjaelken:

B! Mona.jpg* [2:1] (Floating Selection)

Nar du traekker i en selection, udferer du i
virkeligheden to handlinger samtidig: Cut og
Float-Move.

En Floating Selection er ikke en permanent
del af billedet, men kan bevages rundt, som om
den gled i en tynd hinde af olie. Forst, nar du
giver besked om at landsette din selection (med
et hojreklik, Defloat) bliver den atter integreret
i billedet.

En mere skdnsom méade at traekke pé er med
varianten Copy-Float-Move, der gor ngjagtig
det samme, men uden at fjerne den oprindelige
selection fra billedet. Her skal du blot holde Alt-
tasten nede, mens du traekker.

Vil du slippe endnu nemmere, kan du ngjes
med at holde Alt-tasten nede, mens du klikker
én gang inde i din selection (med venstre
museknap). Det vil straks give dig en flydende
kopi at flytte rundt med.

Start forfra pa billedet
med File>Revert.

Lav en ny rektanguler
selection og flyt den med
Copy-Float-Move.

Feather

Med Feather kan du slere kanten pa en selec-
tion over et vist antal pixels. Jo flere pixels, der
skal medtages 1 fortoningen (fra fuld farve til
transparent), jo mere utydelig vil kanten blive.
Feather kan fastleegges pa to mader: fra
Control-panelet eller via Selections—>Modify
—>Feather, der har genvejen Ctrl+H.

Bruger du Control-panelet, Feather
skal Feather-verdien o =
anfores, inden du laver din
selection (ellers virker den
ikke).

Vil du tilfeje Feather til en eksisterende
selection, kan det gores ved at taste Ctrl+H.
Herefter kan du indtaste antallet af pixels i en
dialogboks.

[ Antialias
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Prov nu at indsatte et tredje gje pa Mona Lisa.
Du abner Mona.jpg og serger for at have
Control-panelet synligt. Valg Circle og indstil
Feather til 10. Lav nu en cirkuler selection
omkring det hgjre gje (det gje, du ser til hgjre).

Da en cirkuler selection
tegnes fra centrum og ud-
efter, starter du med at
placere markeren lige pa
pupillen. Tegn en cirkel
sa stor som et brilleglas.

Nar du slipper
museknappen, bliver
omridset (marqueen)
straks 10 pixels storre pé
hver led. Markearen viser,
at din selection nu kan
flyttes.

Hold Alt-tasten nede, mens du klikker inde i din
selection, som dermed forvandles til en Copy-
Float.

Ogsé ved at taste Ctrl+F (Float) kan du
forvandle en selection til Copy-Float.

Nu kan du trekke den
flydende kopi op i panden
pa Mona.

Nér du hejreklikker,
landseettes kopien som en
del af billedet.

G4 nu et skridt baglens i dine handlinger ved at
taste Ctrl+Z (Undo). Det vil annullere dit
hgjreklik og bringe dig tilbage til den flydende
kopi. Du skal nu preve at flytte kopien rundt
ved hjalp af tastaturets piletaster.

Hvis du holder Shift-tasten nede, mens du
trykker pé piletasterne, vil det flytte den
flydende selection i sma trin. En piletast, der
holdes nede i lengere tid, vil medfere en
glidende beveagelse i den enskede retning. For
at afslutte flytningen skal du som tidligere
navnt blot hejreklikke.

Shift+piletaster er meget velegnet, nar en
flydende selection skal placeres pracist.

Antialias

Ordet, der egentlig betyder 'noget for sig selv'
deekker over en udjevning langs omridset af en
selection. En kurve, der ellers ville virke takket,
far med Antialias tilfejet halvgennemsigtige
pixels, der gor kanten mere glat. Antialias kan
minde om en Feather pa 1 pixel, men er mere
ngjagtig og yderst velegnet til f.eks. bogstaver.
Antialias skal indstilles pa Control-panelet,
inden den pageldende selection tegnes.

Onsker du at lave en preecis selection, f.eks.
et rektangel, er det vigtigt, at du fravaelger
bade Feather og Antialias.

Ellers bliver arealet uldent i kanterne!

Arbejd med en marquee

En marquee er den kriblende kurve, der
omkranser en selection. Hidtil har vi
beskeftiget os med, hvordan du kan bearbejde
arealet - de farvepunkter, som ligger inden for
marqueen. Men undertiden kan du have brug
for at bearbejde selve marqueen - altsa uden sit
indhold.

Du kan lave en
sammensat selection ved
at kombinere flere
marqueer. Her kan du
bruge de forskellige
selection-verktajer i
fleng.

Har du tegnet en lasso
med Freehand, kan du
efterfolgende udvide
arealet ved f.eks. at tegne
med Circle mens du
holder Shift-tasten nede.

Omvendt kan du
fratreekke et cirkulart
areal ved at tegne med
Circle mens du holder
Ctrl-tasten nede.

En marquee kan godt omfatte flere arealer, selv
om de ikke er ssmmenhangende.
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En marquee, som du har konstrueret, kan
endvidere flyttes i forhold til billedet.

e Det gor du ved at veelge Mover
og hajretreekke 1 din marquee.

Onsker du at gemme en marquee til senere brug,
veelger du Selections>Save To Disk...
Herved lagres den pa harddisken som en
selvsteendig fil med efternavnet SEL. Giv filen
et beskrivende fornavn, sa du senere far
nemmere ved at genkende den.

Nér du igen skal bruge marqueen, vaelger du
Selections>Load From Disk.., hvorved den
kan hentes med samme udseende og placering.

Leag mearke til, at marqueen i denne
forbindelse (lidt misvisende) gér under
betegnelsen Selection. Det er kun selve
omridset, og ikke dets indhold, der gemmes.

Nar du arbejder med flere lag, er den samme
marquee synlig og anvendelig pa alle etagerne.
Du skal dog vaere opmarksom p4, at den kun
definerer en selection pa det aktuelle lag.

Hvis du f.eks. trykker pa Delete (som sletter
den aktuelle selection), skal du sikre dig, at dit
aktuelle lag rent faktisk er dér, hvor du ensker
marqueens indhold fjernet.

Magic Wand
# Tryllestaven er meget

effektiv til at selecte arealer

med
nogenlunde ens farve. Varktgjet krever dog en
del ovelse med indstillingen af Tolerance.

Brug Ctrl+D (Select None) til at annullere

din selection, hver gang marqueen enten
medtager for lidt eller for meget - og for du igen
prever med en ny Tolerance. Bliver marqueen
for ujeevn, kan du plombere hullerne med
lassoen, mens du holder Ctrl eller Shift nede.

Smart Edge

Smart Edge bruges, nar du skal adskille
farveflader, der steder op til hinanden. Mens
tryllestaven indkredser det areal, hvor farven er
nogenlunde den samme, vil Smart Edge
primert finde en skillelinje mellem forskellige
farver inden for et mere begraenset omrade.

Onsker du f.eks.
at indkredse (for
senere at fjerne)
baggrunden pa
Mona. jpg, kan
det gares ved
forst at udpege
greensen mellem
héret og de bag-
vedliggende far-
ver.

Start med at veelge Freehand.

% [Freshand

Hvis Control-panelet ikke er synligt, trykker du
pé bogstavet O.

Som Selection Type

velger du Smart Edge.
I dette eksempel skal du ,
bledgere din selection HElEEe

med en Feather pa 2. |5I'I'Iaft Edge "i !
Resultatet bliver endnu Feather
flottere, hvis du samtidig I?

9 2 =
aktiverer Antialias.

Iu.:i'[_'.

Controls E

Tool Contralz |

Anbring nu lassoens tradkors et sted pa graensen
mellem héret og baggrunden. Nar du klikker og
flytter markeren mod hejre eller venstre, vil den
efterlade en smal bane (en selection-box) med
konstant bredde. Du skal serge for, at boksen
hele tiden indeholder den granselinje, som du
er i feerd med at kortleegge.
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Nar du atter klikker pa venstre museknap,
forvandles kassen til en takket linje, hvorefter
du kan gé videre med at tegne naste boks i en
ny retning. Med dine klik laver du knaek pa
ruten, som efterhanden kommer til at besta af
en sammenhangende granselinje mellem hér
og baggrund. Undervejs kan du rykke tilbage til
det foregdende knaek ved at trykke pa Delete.

I..:i-[_'.

Nar du synes, grenselinjen har en passende
leengde, afslutter du med et hgjreklik.

Men pas godt pa her: nar du afslutter, vil
greenselinjens forste og sidste punkt altid blive
forbundet til en lukket kurve!

Ligger dit forste og sidste punkt pa hver sin
side af den krumme hovedfacon, vil den
lukkede kurve komme til at deekke en del af
hovedet. Det er ikke s& smart i denne gvelse,
hvor det er baggrunden, der skal selectes (her:
fjernes).

For at undga, at punkterne pa ruten bliver
forbundet hen over hovedet, skal du afslutte
med et par punkter, der drejer greenselinjen
opefter - som om du tog mal til en glorie. Nar
forste og sidste punkt begge ligger hgjere end
hovedet, vil den lukkede kurve udelukkende
komme til at deekke baggrunden.

. -I.“‘.H_'.. I F iy

Fllﬁw'r 3

Hvis du som baggrundsfarve har valgt hvid, kan
du nu erstatte den frembragte selection med
hvidt ved at taste Ctrl+X (Cut).

Pa illustrationerne har jeg lavet en selection, der
kun omfatter en del af greensen mellem har og
baggrund. Du kan p4 samme méde forsgge dig
med Smart Edge i mindre bidder - bl.a. for at
kunne fortryde hver selection med Ctrl+Z.

Nér du bliver mere fortrolig med verktojet,
skal du preve, om du kan indkredse hele
grenselinjen i ét hug.

Ty

Det gor ikke sa
meget, hvis du
ikke far hele
baggrunden
med, nar du
sletter - det
vigtigste er, at
der bliver en
pan overgang
mellem héret og
det hvide.

Den tilbageblevne del af den
farvede baggrund kan
indkredses med Freehand
(denne gang uden Feather
og Antialias). Nar du
undervejs forer lassoen uden
for billedet, vil marqueen
smyge sig taet op til rammen.

En anden mulighed er at vaelge
Selection Rectangle (igen uden
Feather og Antialias) og selecte
en preecis luns af baggrunden.

I begge tilfzlde kan arealet farves
hvidt ved at taste Ctrl+X.

Gem resultatet som Monaface.jpg.
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Copy, Cut, Paste

En af de mest brugbare funktioner i Windows er muligheden for at kopiere, klippe og indsatte bidder
af tekst og billeder fra ét vindue til et andet. I de fleste tilfelde kan operationen udferes pa tveers af
programmer (med de samme genveje), men selv inden for PSP er den til stor nytte.

Genvejene, der geelder som standard i stort set
alle Windows-programmer, hedder:

Copy Ctri+C

Cut Ctrl+X

Paste Ctrl+V

At kopiere vil sige at overfore en kopi af
noget, du har markeret (her: en selection) til det
sakaldte klippebord - et serligt sted i
computerens hukommelse. Under kopieringen
bevares den originale selection, mens kopien nu
kan seettes ind et andet sted (evt. flere gange).

At klippe er det samme som at kopiere, blot
med den undtagelse at originalen slettes.

At scette ind betyder normalt at overfore
klippebordets indhold til det aktuelle vindue.

I PSP bruges Ctrl+V imidlertid i betydningen
Paste As New Image, dvs. at der oprettes et
et helt nyt billede 1 sit eget vindue!

Til gengzld er Paste-funktionen i PSP
blevet udvidet med folgende genveje:

Paste As New Selection Ctrl+E

Paste As New Layer Ctrl+L

Paste As New Selection har overtaget den
traditionelle funktion med at indseette
klippebordets indhold i det aktuelle vindue.

Paste As New Layer vil sige at indsztte
indholdet pa et lag, som samtidig oprettes.

Til avanceret brug har de to sidstnaevnte
genveje faet yderligere et par varianter:

.. Transparent Selection Shift+CtrlI+E

.. Into Selection Shift+Ctrl+L

Paste As Transparent Selection er det
samme som As New Selection, blot med den
finesse at de farvepartier, der matcher med
baggrundsfarven, bliver gennemsigtige.

Paste Into Selection indsztter
klippebordets indhold, sa det deformeres til en
eksisterende selection (bruges sjaeldent).

Abn nu billedet Minirosa.gif,
s& den bla farve er synlig
(tast evt. Shift+V). Dernast
skal du preve at kopiere
blomsten til et andet billede.

For at vaere sikker pé, at billedet kun har de 256
farver, som er obligatorisk for en GIF-fil,
kigger du pa Colors—=>Increase Color Depth:

Decrease ColorDepth » 16 Colors

Increase Color Depth b » EEEREYITE
16 Mio. Colors

Her kan farvedybden kun gges til 16 millioner.
Kigger du pa Decrease Color Depth ..

Decrease Color Depth » RS laTE
Increase Color Depth ™* 16 Caolors
256 Colors

.. ser du, at farvedybden kan mindskes til 2 eller
16 farver. Den eneste verdi, der er gratonet pa
begge menuer, er 256 farver - som netop er
billedets nuvaerende farvedybde.

Du laver med tryllestaven en selection af det
bla, som du dernest @ndrer til sin modpart med
Selection—>Invert. Nu er blomsten indfanget
og kan kopieres med Ctri+C.

Du abner Mona.jpg, hvis
farvedybde du evt.
forinden har sikret dig er
pa 16 millioner farver.
Her indszaettes blomsten
med As New Selection:
Ctrl+E.

Resultatet far altid den samme
farvedybde som det modtagen-
de billede. Kopierer du i stedet
en selection fra Mona til
Minirosa, bliver den
automatisk omdannet til kun
256 farver!
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Andring af areal

Sterstedelen af dine verktgjer og de justeringer, du foretager via menuerne, har kun virkning inden for
den aktuelle selection. Pa denne made setter marqueen fokus pé dine handlinger og udelukker det

areal, som ikke er omfattet af din selection.

Du kan se princippet ved at lave
en mindre selection, f.eks. et
vandret rektangel midt i billedet,
- og dernast male skrdt henover
det med en red pensel.

Penslen afsetter kun farve, sa
leenge du maler inden for din

selection. Denne egenskab

. geelder for alle vaerktejer, der
tilfejer farve til billedet.

Gentager du spegen efter at have
. vendt vrangen ud pa dit areal
med Selections—=>Invert, vil

- farven kun blive péafert uden for
rektanglet.

Overraskende nok vil penslen male uforstyrret,
hvad enten du har tastet Ctrl+A (Select All)
eller Ctrl+D (Select None).

Det bemarkelsesvardige er, at der sker en
begreensning 1 verktejets udfoldelser, nar blot
en enkelt pixel er selected.

Gennem nogle maneder har jeg studeret
spergsmal og svar i nyhedsgruppen
comp.graphics.apps.paint-shop-pro.
For mange brugere var det ofte et problem
at fa et af programmets vaerktojer til at
fungere efter hensigten. | de fleste tilfzlde
var arsagen en glemt eller overset selection,
der blokerede for det gvrige billede. Sa
snart der blev tastet Ctrl+D, virkede alting
igen.

Normaltilstanden er Select None, der vil fa
veerktejerne (og menuerne, som vi skal se 1 det
folgende) til at virke pé hele billedet, pa samme
made som hvis du havde valgt Select All.

Rade gjne

Nu skal du abne billedet -
Amalie.jpg, hvor gjnene er ﬁ

blevet rade pa grund af en : -
gammeldags blitz. s
Der er flere mader, hvorpa du kan give gjnene
et mere naturligt udseende, men her skal du
inden for et begraenset areal prove at forskyde
farvebalancen . Det gor du med Colors—>
Adjust->Red/Green/Blue eller med genvejen
Shift+U.

Forskyder du farvebalancen uden at have
foretaget en selection, sker &ndringen for hele
billedet. Det kan du indledningsvis preve for at
stifte bekendtskab med verdierne for Red,
Green og Blue.

Treek f.eks.
skydeknappen for
Red mod venstre
til veerdien -40.

For Efter

For at fjerne de rede gjne skal du imidlertid kun
@ndre farver pa et afgrenset areal. Dette kan
kun lade sig gore, nér billedet (som i dette
tilfeelde) har en farvedybde pa 24 bit. Med en
lavere farvedybde mé du nejes med at udfere
@ndringen pa billedet som helhed.
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Med forsterrelsesglasset zoomer du ind pa den
rede regnbuehinde i billedets venstre side. Velg
en pan forsterrelse, f.eks. 12:1.

Med Freehand
leegger du en lasso
(Feather 0) rundt
om alle de redlige
pixels. Medtag evt.
flere pixels ved at
holde Shift-
knappen nede
imens.

Den lyse refleks i midten bliver en del af din
selection, men den kan du senere behandle
serskilt.

I de to ruder ogverst i dialogboksen kan du se
resultatet for og efter dine @ndringer. Du kan
zoome ind pa din selection ved at klikke pa
knappen med [+ .

HEd,:'Green,-"BIue

Zoom 10:1 J % F%guh:u Proaf

Vealger du Auto Proof, far du opdateret det
originale billede i takt med dine indstillinger.

b4 E ed: Trek
- \ skydeknappen mod
— I_ |-4EI venstre (negativt
e tal) eller skriv i

ruden: Red: -40,
Green: -20, Blue:
-20. Den rogde farve
forsvinder fra

arealet, og du
klikker pa OK.

Da den hvide
refleks er blevet for
maerk, skal den nu
lysnes efter samme
recept. Du ophaver
din hidtidige
selection med
Ctrl+D og tegner en
ny.

Denne gang
treekker du
skydeknappen mod
hgjre eller skriver i
ruden: Red: 60,
Green: 60, Blue:
60.

Refleksen bliver
lysere, og du
godkender med
OK.

Tast igen Ctrl+D for at ophave din selection og
zoom ud med minus-knappen for at se
resultatet.

Nu zoomer du ind péd det andet gje og giver
det en tilsvarende behandling. Ved at bruge
forsterrelsesglasset til at zoome med (i stedet
for blot at trykke pé plus-knappen) far du
anbragt gjet midt i det forsterrede billede.

Til sidst taster du F12 og gemmer billedet
som Amalie2.jpg. Dette billede skal bruges i en
ny evelse pé side 38.
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Filtre

Et filter er en effekt, du kan anvende pé en selection eller et helt billede. Virkningen spaender lige fra
klassiske @ndringer som f.eks. Blur, der slorer de enkelte pixels, til hejst specialiserede krumspring.

Adgangen til filtrene sker via menuen Image.
For at fa et indtryk af deres virkning &dbner du et
24 bit billede som Mona.jpg og velger
Image—>Filter Browser.

=]|

Filter Browser

Sample preview

Filker narne:

Mens du pa skift markerer de enkelte filtre pa
listen i venstre side, kan du se en mini-udgave
af resultatet i ruden Sample preview. For at
uddybe anvendelsen af det pagaldende filter,

skal du klikke pa Apply.

Block Width: Hvert filter har sin egen
Pl ' [+ dialogboks, hvor du kan
:I fastlegge detaljerne.

Block Height For Mosaic er det
] """"""" '+ sterrelsen pa de enkelte

blokke (malt i pixels), der

V¥ Summetric:

kan specificeres.

Forst, nar du klikker pa OK, bliver andringen
sat i veerk pa det oprindelige billede. Resultatet
kan i evrigt fortrydes med Ctrl+Z.

Blur

Nu skal du afpreve et filter pa en mindre del af
dit billede. Du skal anvende Gaussian Blur -
en sloring, der udferes efter en sindrig
beregning, og som jeg synes, giver et flot
resultat.

Hvis du allerede har anvendt et eller flere
filtre pA Mona.jpg, vender du forst tilbage til
det oprindelige billede med File->Revert.

Nu indrammer du
ansigtet med Freehand.
Lassoen behgver ikke
ramme sa pracist, fordi
du efterfolgende valger
Selections>Modify>
Feather og bledger din
selection med 3 pixels.

Nu vaelger du Image—>Blur->Gaussian Blur.
Selv om dette filter ikke har sin egen genvej,
kan du aktivere det med rasterne ved at bruge
de bogstaver, som du ser understreget i
menuerne. Du skal taste: Alt+], dernast B,
dernaest G. Nar du skal indlede med Alt-tasten,
skyldes det, at Image er en menuoverskrift.

Gaussian Blur har
kun én parameter:
Radius pé den
slering, som hver
pixel skal udsattes
for. Vaelger du Auto
Proof, kan du se
resultatet,
efterhanden som du
@ndrer vaerdien.

I dette tilfzelde
vaelger du 2 pixels og
godkender ved at
klikke pa OK.

Gaussian Blur |

B adius: |2 3:

Du fjerner marqueen
med Ctrl+D og ser
nu ansigtet sloret,
mens resten star
skarpt. Prov dernzast
at fortryde 2 skridt
baglaens med Ctrl+Z
og lav Blur pé alt
undtagen ansigtet.
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Her er flere eksempler pa anvendelsen af filtre.
Det er kun det selectede ansigt, der er aendret.

R Under Edge,
4 der bl.a. kan
forsterke
overgangen
mellem
forskellige
farver, findes
ogsa Trace
Contour, der
laver en slags
bly-
antstegning.

Mosaic
opdeler
billedet i
ensfarvede
kvadrater, lige
som en
stiftmosaik.

Emboss giver
en metalagtig
overflade, som
om billedet var
hamret ud i en
selvplade.

Plugin filtre

De filtre, du kan finde i Filter Browser (og som
menupunkter), folger med programmet.

Efterhanden som du
fér erfaring med '
disse filtre, vil du
maske fa smag for
andre og mere ek-
sotiske effekter.
PSP 5 er bygget til
at kunne gere brug
af filtre, der impor-
teres udefra.

Sterstedelen er lavet til store (og dyrere)
programmer som PhotoShop, men mange af
dem kan ogsé bruges i Paint Shop Pro.
Verktejer, der pa denne méde kan hentes og
'stikkes ind' blandt dine egne redskaber, kaldes
plug-ins og findes i mange variationer pa
Internettet.

En fin oversigt over plug-ins til Paint Shop
Pro finder du hos det svenske Grafo Maniac,
hos Prosperity Place i USA samt hos det
danske Prosoft.

Du kan se genvejene til disse steder pa
forlagets hjemmeside
www.aha.dk/filter.htm

Da mange af forklaringerne og henvisningerne
pa de udenlandske steder er lidt sveere at finde
rundt i, er der hdndplukket en raekke gratis
filtre, som du kan hente direkte fra den navnte
hjemmeside. For at forkorte overferselstiden er
filtrene pakket som zip-filer. Anvendelsen
kreever altsa, at du har WinZip (eller et
tilsvarende program), som er nasten
uundveerligt, nar du henter filer pé nettet.
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Installation

Du kan udpakke de zip-filer med filtre, du har
hentet, i en felles mappe pa din harddisk.

Jeg foreslar at du opretter en ny mappe ved
navn Plugins i den mappe, hvor programfilerne
til Paint Shop Pro ligger.

& C\_\Paint Shop Pro

‘Eiler Bediger Wis Skift

Luk m  Genwvej
[ ——

P& min computer har den nye mappe adressen:
C:\Programmer\Paint Shop Pro\Plugins.

I mappen Plugins kan du enten oprette en
undermappe for hvert filter, f.eks.
FilterFactory, eller du kan udpakke alle filtrene
hulter til bulter i Plugins. Resultatet bliver det
samme.

Hvis du har WinZip installeret, kan du
markere zip-filen og hejretreekke den (holde
hgjre museknap nede, mens du bevager ikonet)
over i Plugins:

& CA A\ \Plugins MEIE

| Filer Rediger Vis |

@ cpkplug. zi k

Extract to CA . \Flugins |

Kopier hertil
Opret genveje her

L

BN

Annuller

P4 den lille menu kan du valge at udpakke
(Extract) zip-filen, der bliver i sin oprindelige
mappe, og kun afgiver en kopi af sit indhold til
Plugins.

& CA A\ APlugins M=l B3

| Eiler Bediger vis |

2Dt BbF ] Colarize. afs

CKpegs. Bb (2B Flexem. bt
CEpegs. afs Flexem. afs

Calorize. b [ InB ack.5hf

|15 objekter] |_§‘ Denne computer

Nar filtrene er kopieret til Plugins, skal du
fortaelle Paint Shop Pro, hvor de nye filtre
befinder sig. Det gor du ved at starte
programmet og velge File>Preferences>
Generel Program Preferences:

% Paint Shop Pro
Iwil=W Edit %iew Capture Help

Mew. . IJ_QIEW I | K?

Open...

h[:i eneral Frogram...
MK Conwversion ...
File Associations...

Under Preferences velger du Plug-in Filters,
setter hak 1 alle ruderne og skriver stien til
mappen Plugins i ruden Folder 1:

Paint Shop Pro Freferences |
Mizcelaneous | Rulers and nitz I Curzors I
Undo F"Iug-in Filkers | ".‘."iewing

—&dobe Compatible Image Frocessing Filkers
¥ Enable filters - Allow the use of external
W |nciude sub-folders when zearching for filters
¥ Limit loaded plug-in files to 8B extension
¥ Enable plug-in automatic file identification

Folder 1: IE:'&..S\.F‘.&INT SHOPR PROPluging

k. ; I Annuller Hiz=lp

I de gvrige ruder, Folder 2 og Folder 3, kan du
evt. anfere maper, hvor andre af dine
grafikprogrammer har filtre liggende.

Nér du har klikket pad OK, kan du finde de
nye filtre ved at vaelge menupunktet Plug-in
Filters nederst i menuen Image. Hver gruppe
vil veere ordnet med sin egen undermenu:

Archie's Spirals...
Cartaan Ar...
Srmiley...

CFE Designs
Filter Factony A
Filter Factory

Rl - -

MY F Borderbdania
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Tekst

Med tekstverktajet og den dertil herende dialogboks kan du indsette tekst p& dine billeder.
Teksten indsattes som en standard selection, der vil fa de samme farver som det indkredsede areal.
Onsker du at lave en ensfarvet tekst, skal du inds@tte den som en floating selection.

Selv om den sidstnavnte mulighed, floating
selection, kan forekomme mere speciel end
standard selection, er den pd mange mader
mere anvendelig. Dels er teksten nem at placere
pé billedet, dels medferer det, at teksten far
samme farve som forgrundsfarven.

Til denne gvelse abner du
Mona.jpg, valger hvid
som forgrundsfarve og
klikker med
tekstverktojet lige
mellem gjnene.

I dialogboksen Add Text skriver du Mona med
Times New Roman i sterrelsen 48 punkt.

Add Text |
— Faont attributes — T ext effects—
M ame: [T Strikeout
Times Mew Raman W L

Sustem - R
V¥ antizlias
Verdana
% ﬁﬁhlﬂ_ﬂgs j — Alignment
ingdings & Leit
Sample at 1:1 zoom: ¢ Center
Mong “*
¥ Floating

Enter text here:
IM ana

Cancel Help
N

Du aktiverer bade Antialias og Floating.

Alignment (venstre-, centreret eller
hgjrejusteret tekst) har kun betydning, hvis du
skriver flere linjers tekst.

Nar du klikker pa OK, vil midtpunktet af den
komponerede tekst blive anbragt dér, hvor du
har klikket. Denne made at placere teksten pé er
ikke i sig selv videre ngjagtig, fordi du ikke pa
forhénd kender dens udstrakning.

Da du i dialogboksen har
. valgt Floating, bliver

4 : markeren imidlertid til en
' flyttepil, hvormed du frit

i kan flytte teksten rundt pa
billedet.

Laeg merke til virkningen
af Antialias: de krumme
former opbledes i kanten
med halvgennemsigtige
pixels, hvis farver
afpasses efter billedet.

Forst nér du hejreklikker,
annulleres din Floating
Selection, hvorefter
teksten bliver en
permanent del af billedet.

Prov at nu fortryde dine sidste handlinger (dvs.
flytning samt tekst) og vaelg baggrundsfarven
rod. Brug nu atter tekstverktejet, men denne
gang uden at vaelge Floating i dialogboksen.

Resultatet bliver en tekst
(en standard selection)
med billedet indbygget i
bogstaverne. Nar du
treekker 1 teksten, vil den
efterlade et redt aftryk.

Hvis du inden flytningen
gor din selection flydende
med Ctrl+F (Float), vil
den fortsat medtage
billedets farver, men uden
at efterlade det rade
aftryk.

Egenskaben Floating ger altsa kun teksten ens-
farvet (efter forgrundsfarven), nér den veelges
allerede i dialogboksen.

I version 6 kan du lave tekst som vektorer.
Las mere om det pé side 44.
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Lag

At tilfeje et nyt lag svarer til at leegge et stykke gennemsigtig film ovenpé det oprindelige billede. Ved
at arbejde i lag kan du kontrollere billedets bestanddele enkeltvis.

For at kunne folge med i arbejdet med lag skal
du gere Layers-panelet synligt ved at taste
bogstavet L (uden brug af Shift-tasten).

Layers

| Backgrnu[d TLT_[ A‘J ——1 100 )

el el

\\ |-Delete NameJ L LGVOUP

New Show Protect — Opacity

Det oprindelige billede kommer altid til at ligge
nederst med navnet Background. Efterhanden
som du tilfgjer nye lag, anbringes de opefter i
en stak, saledes at pixels pa et lag altid vil deek-
ke for dem, der ligger l&ngere nede.

Klikker du pa knappen New i panelets
nederste venstre hjorne, skaber du et nyt lag. I
dialogboksen Layer Properties far du

mulighed for at give laget et navn efter eget
valg.

Layer Properties |
— Layer
M arne; ILa_I,Ier'I
Blend kMode: INDrmaI "I
Opacity: 100 =
= & Layer iz visible
Group: I':I _I? r Brotect transparency

Cancel | Help |

Blend Mode bestemmer, hvordan farven skal
blandes mellem de enkelte lag. Her kan du
vaelge mellem en raekke avancerede metoder,
men jeg anbefaler, at du holder dig til Normal.

Opacity er deekkeevnen af de farver, du
péferer laget. Den kan du senere regulere
procentvis fra O til 100 med panelets
skydeknap. Group setter dig i stand til at
inddele dine lag i grupper, som kan flyttes
samlet.

Protect Transparency serger for, at de dele af
laget, der pa et givet tidspunkt er
gennemsigtige, ikke kan fa tilfort yderligere
farve.

Egenskaben kan nér som

helst slés til eller fra med et El E
klik pa knappen med lasen.

Det normale er Unprotect. Unprotect  Protect

Det nye lag dukker op oven over Background:

Layvers

Layer Iﬁ pal _"I —1 100
B ackground "ﬁ pal _I — 100

al | y

I panelet har hvert lag en knap med sit navn.
Den knap, der ses trykket ind, er det aktive lag
(Current Layer).

Ved at klikke pé en knap kan du pa skift
gore de enkelte lag aktive.
Du kan kun arbejde pd det aktive lag!

I de fleste tilfeelde er lagene synlige samtidigt,
og du skal derfor altid sikre dig, at det aktive
lag faktisk er dét, du vil arbejde pa.

Vil du flytte et lag til en anden plads i
stakken, kan du traekke knappen og slippe den
pa det onskede sted:

Background Iﬁ

Backaground

Med et klik pa regnbue-knappen
kan du gere laget skiftevis —
usynligt og synligt. Det kan vare a
til stor nytte, nar du vil studere
indholdet af de enkelte lag.
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Deformation

Abn billedet Amalie2.jpg, hvor de rede ajne er
blevet farvekorrigeret. Du skal nu lave en
&ndring af leberne med varktojet
Deformation, som kun kan anvendes pé en
Floating Selection eller (som her) pi et
selvstendigt lag.

I denne avelse overforer du en kopi af det
pageldende areal til et nyt lag for at kunne
arbejde uforstyrret med dine @&ndringer.

Du starter med
at lave en
rektangulaer
selection, der
indbefatter
leeberne.

Du kopierer med Ctrl+C og indsatter kopien
som et nyt lag ved at taste Ctrl+L.

Du ser nu begge
udgaver af din
selection -
muligvis forskudt
i forhold til
hinanden.

Laeg merke til, at marqueen, som har vaeret
brugt til den oprindelige selection, stadig kan
ses pé tvaers af lagene. Det kan du bruge, hvis
du vil flytte kopien, sa den sidder lige oven pé
originalen.

Pa Layers-panelet gor
du originalen,
Background, usynlig
ved at klikke pa dens
regnbue-farvede knap.

Layerl

[
Background |%

alicl

Pé det nye lag ser du nu tydeligt kopien, som du
med Mover-vearktgjet kan treekke hen, sd den
passer i marqueen.

, ' P4 ner din
: ' selection er
: . alting pa

| . dette lag

. transparent
(og vises
ternet).

Efter flytningen
kan du kontrollere
placeringen ved
kortvarigt at
tende og slukke
for det nederste
lag.

IE Da du arbejder pa et lag, er vaerktojet
Deformation synligt og brugbart.

I det gjeblik, du
aktiverer
vaerktojet,
indrammes din
selection af et
rektangel med en
rekke héndtag.

Pinden i midten
med de to handtag
bruges til rotation.
Du treekker i
handtaget midt pa
bundlinjen..

..som udvider
arealet i
nedadgaende
retning.
Marqueen bliver
stdende og
antyder
@ndringen.

Nér du er tilfreds med din
deformation, godkender
du med knappen Apply pa
Control-panelet.
Zndringen er nu blevet en
permanent del af laget.

Du kan studer

Cl:lnlrl:lls

Tool Controls | Brush Tip I

ﬁppl}l

Cancel

forskellen pé for og efter
HeEl ved at teende og slukke
Background @~ for det nye lag - eller du

kan lade laget vaere
synligt..

-ﬁﬂ_ﬂ— 32
Jﬁ@_ﬂﬁmu

Det ligner naesten en animation.

el sl

..mens du treekker
i skydeknappen
Opacity.
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Merge

Et billede med flere lag kan godt gemmes, sa du
senere kan genoptage arbejdet. Det kraever
imidlertid et serligt filformat, der kan opbevare
de enkelte lag, f.eks. det indfedte Paint Shop
Pro-format PSP. De fleste andre filformater
understotter ikke lag, og her ma du sla lagene
sammen ved at fladtrykke (Flatten) billedet,
inden det gemmes.

Undervejs i dit arbejde kan du ogsa have
brug for at ssmmenflette (Merge) enkelte lag.
Det gar du ved at slukke for de avrige lag, s&
kun de lag, der skal flettes, er synlige (Visible).
Dernaest velger du Layers>Merge—>Merge
Visible.

I det aktuelle eksempel med Amalies mund
skal du afslutningsvis kun flette to lag ..

.. 88 her kan
du bruge
Merge All.

Den nye mund
pa det gverste
lag vil nu blive
en del af det
underliggende
lag.

Du reparerer ujeevnhederne med Clone Brush
og gemmer billedet som Amalie3.jpg.
o T

Prov nu at lave
to nye lag med
hver sin tekst af
forskellig
starrelse ovenpa
Mona.jpg.

Du starter med
at oprette
lagene, som du
kalder Mona og
was here.

w & ; ere

Du klikker pé& knappen

Mona for at gere dette lag
til det aktive lag (Current
Mana L\\S Layer).

Dernzaest veelger du tekst-
vaerktajet.

waz here

Background

Frembring dialogboksen Add Text ved at
klikke pa ansigtet midt i panden.

Ve&lg Times 36 punkt normal og skriv Mona.
Husk bade Antialias og Floating.

W&‘? 5 Nar din marker er vaek
o 3 fra din selection, er

\ den en tekstmarkeor.
I neerheden af teksten

bliver den en flyttepil.

Du flytter teksten til det gnskede sted og laver
Defloat med et hejreklik.

Klik nu pa knappen was here for at gore
dette lag til det aktive. Brug denne gang tekst-
verktejet til at skrive was here med Times 24
punkt kursiv (Antialias og Floating). Flyt
teksten til det merke omrade under hagen og
hgjreklik for at defloate.

Du skal undga at defloate din selection, feor
hele teksten befinder sig inde i billedet.

Ellers risikerer du, at den
ikke-synlige del gar tabt.

18 here

Du kan se en

miniudgave ) =1
af indholdet Was ners MNew.
pa hvert lag baona —
;Ziitaggiel Backaround I} Dielete

L k) .
et stykke tid. w Eroperties...
Et hejreklik View \
pa samme -
knap lderge ¥
Zfﬁ?él?riiu Background Fromote...

New laver et nyt (tomt) lag. Duplicate laver et
nyt lag med en kopi af det aktuelle lag. Delete
sletter laget (samme resultat far du, hvis du
treekker laget ned pa ikonet, der forestiller en
skraldespand). Properties ébner dialogboksen,
hvor du bl.a. kan @&ndre lagets navn. View gor
det aktuelle (eller samtlige) lag synlige. Merge
sammenfletter de synlige (eller samtlige) lag.
Promote omdanner Background til et lag,
saledes at indholdet kan skifte plads i stakken.

Naér du har flettet dine lag med Merge,
gemmer du billedet som MonaZ2.jpg.
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Maske

En maske er en gradueret udgave af en selection. Mens en selection lader farverne skinne igennem
indenfor et bestemt areal og holder dem tilbage alle andre steder, tillader en maske farverne at passere

med skiftende grader af gennemslagskraft.

Forestil dig en
selection som et stykke
pap, hvor et areal er
skéret vaek - som en
skabelon med hul
igennem.

Da udvelgelsen kun omfatter farvepunkterne
inden for hullet, repraesenterer det hvide omrade
en virkning pa 100%, mens det sorte omrade
repraesenterer en virkning pa 0 %.

Til sammenligning vil
en maske vere et
tradvaev med
varierende tethed - pé
samme made som en
stencil.

I det viste eksempel vil farvepunkterne pavirkes
100% inde i midten (hvor masken er hvid),
mens de far aftagende styrke ud mod kanten af
masken (hvor masken er sort).

En maske er netop en sadan grdtonet
afbildning af farvernes gennemslagskraft.

Et hvilket som helst billede kan anvendes
som maske for et andet. Billedet, som danner
grundlag for masken (dens kilde, Source),
behover ikke at veere grdtonet fra starten - det
ordner programmet selv undervejs. Heller ikke
kildens storrelse er kritisk, da masken
automatisk streekkes, sd den passer til det
billede, hvor den skal virke.

En maske laves som et midlertidigt tilbehor
til et billede. Du kan fa den at se pa skeermen og
du kan tilmed redigere den med malevarktajer
og filtre. Nér maskens virkning er slaet igennem
- ndr den er flettet ind 1 billedet med merge -
vil du normalt slette den igen.

Lige som med lag er det de ferreste
filformater, der kan opbevare en maske sammen
med billedet. Inden du gemmer et billede, som
indeholder en maske, opfordres du som regel til
at flette (merge) masken, inden den gar tabt.

Nu skal du pa Mona.jpg
fremstille og anvende en
sadan maske, der toner fra
midten og udefter. Jeg
viser kun en fjerdedel af
billedet for at spare plads.

Mpgnsteret har navn efter
sollys, der bryder gennem
en sky: Sunburst
Gradient. Det kan laves
som en Fill Style med
malebgtte-vaerktajet.

Nér du har &bnet billedet, vaelger du fra menuen

Masks—>New—->Hide All:
LR Y |
Shoree All
e Mask Erarm Image...

Som neevnt kan masken laves ud fra et billede
(From Image), og det skal du prave senere. |
dette eksempel skal den imidlertid zegnes, og
derfor kan du starte med at vaelge Hide All, som
giver en totalt dekkende maske.

Maskens virkning pa
billedet viser sig straks.
Billedet er nu kun en
transparent (ternet) flade.
Havde du valgt Show All,
ville billedet kunne ses.

Nér du tilfgjer en maske, er det dens virkning,
du ser. Normalt er selve masken usynlig.

For at gore den nemmere
at arbejde med, kan du
gore masken synlig ved at
veelge Masks>View
Mask, hvorved den far en
rubinrod farve.
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At gore masken synlig (rubinrad) er kun forste
skridt pa vejen. For at kunne andre maskens
udseende skal du dernast veelge Edit Mask.

Denne indstilling, der viser
MNew sig ved et hak ud for Edit,
o naeste gang du kigger i

Delete rullemenuen, er lidt lumsk.
Invert Glemmer du at annullere
v Edit p Edit, ndr masken er ferdig,
¥ Niew hask fér du nemt problemer.

Nar du tegner, mens Edit Mask er aktiv, vil
hvid farve lave huller i masken og gere den
mere transparent. Omvendt vil sort farve oge
maskens udstraekning og gere den mere tcet.

Inden du forsyner din maske med
Sunburst, laver du hvid
forgrundsfarve og sort

baggrundsfarve.

For at udfylde Controls
mcasken klikker du Tool Contiols | Brush Tip I
pa malerbette-

vaerktajet. Fill Style

Du ger Control- ISunI:uurst Gradient LI
panelet synligt og M atch mode

veelger Sunburst
Gradient. Match

IFEGE Walue vI

mode RGB, Taolerance  Opacity
Tolerance 200, (T I
Opacity 100. —
Dernaest k.hkker Dptu:uTs | r Merged
du pa Options.
Flood Fill Options 3 |ERERRCEURAl
Options kan du

indstille forlgbet

Fill: ISunI:uurst Gradient ;I
af din udtoning.
Det lyse omrade

Blend: INnrmaI bl I
placeres i

) midten ved at du
veelger 50%
) bade Vertical og
- Horizontal.
) Nar du har
: godkendt med
OK, er din
Flood Fill klar
til brug.

I samme gjeblik, du
klikker pé billedet med
malerbgtten, udfyldes
masken med sunburst-
mensteret, og billedet
dukker op i den
afmaskede form.

ground _I]le

Vil du se masken alene,
kan du slukke for din
Background.

Hvis du gemmer dit billede nu som JPG, vil
masken automatisk blive flettet ind i billedet
(merged) og fa den virkning, du ser pa
skeermen. I denne proces bliver masken slettet.

Har du et enske om at bevare masken for
senere at bruge den pa samme (eller pa et helt
andet) billede, kan du forinden gemme masken
som en seerskilt fil med efternavnet msk (en
forkortelse for mask). Du vaelger Masks—>
Save on disk og gemmer masken som
Sunburst.msk:

Save Mask Channel |

Gem i I 5] Paint Shop Pro & LI
Anirmnz (=) Paperz
Bruzhes — Plugir
Images [ Profiles
Falettes [ Tubes

Filarer: Isunl:uurst mzk,

Filtype: IF'SF' task Channel _I Annuller |

For at rydde op efter dig inden afslutningen ber
du nu i rullemenuen fjerne hakkene ud for
Mask Edit og Mask View (ved at klikke pa
punkterne enkeltvis).

Oprydningen er iser
vigtig, hvis du vil foretage
@ndringer pa billedet.

Sa lenge Mask Edit er
aktiv, pavirker dine veerk-
tojer nemlig kun masken!
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Vil du veere ekstra grundig, kan du tilmed slette
masken. Som naevnt sker det automatisk, hvis
du gemmer billedet i sin nuvaerende form, men
det kan blive aktuelt, hvis du vil arbejde videre
med en ny maske.

For at slette masken valger du Masks—>
Mask delete. Du bliver nu spurgt, om du inden
sletningen vil drage nytte af den nuvarende
virkning (som er den, du ser pa skaermen) eller
om den ligeledes skal fjernes (s& du kan bringe
billedet tilbage til sit udseende for masken).

Paint Shop Pro &

“WWiould vou like thiz mask merged
ifita the current layer?

Svarer du Ja til at flette, kan du f.eks. lave en
ny maske, som bygger videre pa resultatet af
den foregaende.

Ved at trykke pa F12
gemmer du billedet som
Monasun.jpg. Neste
gang du abner billedet, vil
baggrunden veare hvid i
stedet for transparent.

Til den naeste ovelse skal du bruge to
forskellige billeder, der er lige store (med
samme bredde og samme hgjde mélt i pixels).
Det ene billede laves som et udsnit af Cox.jpg,
som du forst dbner. Det andet billede er
Mona.jpg, som du ligeledes abner.

Vealg Mona som det aktive vindue og lav en
kopi af indholdet med Ctrl+C. P4 Cox
indsetter du Mona som et nyt lag ved at taste
Ctrl+L.

Layerl

Background |

P& det nye lag laver du
en rektanguleer
selection uden om
Mona.

Ved hjeelp af et trick skal du nu fa din marquee
til at skrumpe preecist til storrelsen af Mona.

P4 det nye lag findes der ingen pixels ud over
kopien af Mona (resten er transparent).

Hvis du pa sadant et
lag har lavet en
selection, der omfatter
mere end de
eksisterende pixels,
kan du fa den til at
skrumpe ved at taste
Ctrl+F (Float).

Nu har din marquee
samme storrelse som
Mona, og du taster
Shift+Ctrl+F
(Defloat).

Dernaest sletter du
laget ved at veelge
Layers—>Delete.

Marqueen kan nu med
vaerktejet Mover
hejretraekkes hen til
det sted pa Cox, hvor
den fanger et paent
motiv. Her beskarer
du med Shift+R
(Crop).

Tast F12 og gem billedet som Minicox.jpg.
Nu skal du ud fra dette billede lave en
maske, som skal anvendes pa Mona.jpg.

Som tidligere nevnt behgver maskens
Source ikke at have samme storrelse som
det billede, den anvendes pa.

Men resultatet bliver nemmere at styre, hvis
de (som her) passer sammen.

Med Mona.jpg som det aktive vindue valger
du Masks>New->From Image:

Cgph (o WAdime mnas

Hide All
Showe All

Yiew bdask

Ved at anvende muligheden From Image.. far
du bl.a.lejlighed til at specificere, fra hvilken
kilde (Source) masken skal dannes.

42 © Steen Juhler, 1999, 2002



I dialogboksens rude Source Window, kan du
finde navnene pa alle de billeder, der er abne i
programmet. This Window er navnet pé det
billede, som skal hruge masken (Mona.jpg).
Lige nu er det Minicox.jpg, du skal have fat i.

Add Mask From Image |

Source window:

I biricom. jpg
Create maszk. from
. Source luminance
= “Any non-zero value

= Source Dpacity

Der er to egenskaber ved billedkilden, du kan
veelge som udgangspunkt for din maske:
Luminance (lysstyrke) og Opacity
(deekkeevne). Desuden kan du seatte masken til
at dekke alle pixels pé kilden: Any non-zero
value.

I dette tilfeelde skal du bruge Luminance,
der laver masken som en gratone-udgave af
kilden.

Naér du klikker
pa OK, traeder
masken i kraft.
Hvis du vil vise
den transparente
baggrund som
hvid, skal du
forst gemme
resultatet og
dernast abne
billedet pany.

Hvis du nederst i
boksen Add
Mask satter hak
ud for Invert..

IV |rvert mask data

.. vil masken
virke negativt:
dens sorte
omrader bliver
hvide og
omvendt.

Nu skal du prove at redigere en maske med dine
malevearktojer.

Du abner Mona.jpg og henter masken
Sunburst, som du tidligere har gemt pa
harddisken.

Vealg Masks—>Load From Disk og
dobbeltklik pa Sunburst.msk. Dernzst valger
du Masks->View efterfulgt af Masks—> Edit.
" Prov forst at tegne en fed
 streg skrét hen over
masken med en hvid
pensel: Size 20, Opacity
100.

Stregen efterlader en
tydelig abning til Mona.

For at koncentrere dig om
masken, slukker du for
din Background :

ground _I]le

Prov at skifte forgrundsfarve ved at
dobbeltklikke pé den hvide.
Da redigeringen af en maske altid
foregar med grdtoner, kan du kun veelge
mellem 256 nuancer af gra.

Hvis redigeringen af den sarte Sunburst-
maske ikke skal blive for voldsom, er du bedre
tjent med en forsigtig Airbrush. Prov det!

=

Du sletter masken uden at
merge og henter en frisk
udgave af Sunburst.
Husk Masks—->View
efterfulgt af Masks—>
Edit.

Tegn med hvid
Airbrush (Size
20, Opacity 20)
inde i midten af
masken.

Nér du taster
F12 og gemmer
billedet som
Monasun2.jpg,
vil virkningen
sld igennem.
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Vektorer

I version 6 af PSP kan du ved hjaelp af vekrtorer lave figurer, der i stedet for billedpunkter bestér af
geometriske formler. F.eks. vil en cirkel vare helt rund, séleenge den er baseret pa vektorer.
Den krumme figur fér forst takkede kanter, nr den pé et senere tidspunkt omdannes til pixels.

For at tegne med
vektorer veelger du
specialvarktajet
Draw.

L
=]

Dine streger kan

Frezet Shapes
Wector Object Selection

Tool Options - Draw

tegnes som o b,
Single Line, & A -
Bezier,

Freehand eller
Point to Point.
Figuren kan

Type: IF'I::int to Point Line
Style: | Filled -

Wit I'I _I? zI

veere Filled

(udfyldt), ¥ Artialias
Stroked ¥ Create as vector
(omrids) eller

begge dele.

Selv om du tegner med vektorer (Create as
vector), skal programmet kende stregernes
pixel-egenskaber sa som Width og Antialias.
Det skyldes, at hvert objekt, du tegner (f.eks. en
lukket kurve), skal kunne omdannes til
farvepunkter efter feerdiggerelsen.

i Image 1 =] E3

Prov at lave et nyt
billede pa 200 x 200
pixels med hvidt
leerred. Her tegner du
et M med Point to
Point.

Som Style velger du A
udfyldt, Filled.
Markeren bliver en sort pil med et plustegn.
Hver gang du klikker, dannes et nyt punkt, der
er forbundet med det foregéende via en streg.

Nar du har tegnet K Image 1 M[=1E3
figuren, afslutter du r - -
Draw ved at klikke

uden for billedet.
Figuren ses nu i sin
farve-udgave omgivet
af en select-boks til at
flytte, rotere eller
streekke figuren.

Boksen fjernes med Ctrl+D (Select None).

Pa Layer-panelet vil du kunne se, at der nu er
fremkommet et nyt vektor-lag:

i Image 1 M= E3 |

Layer Palette - Layerl

Vektorlag

Rasterlag Layert
Klikker du pa plus- T

tegnet ved siden af
vektorsymbolet, ser du
alle lagets objekter.

Et dobbeltklik pa et enkelt af disse objekter
viser dets egenskaber m.h.t. fremtoning:

Yector Properties E

M ame: IDrawing

Style: IFiIIeu:I vI ¥ Wisitle W Antislias

Antialias sikrer et nogenlunde blgdt udseende.

: ™2 Drawing [:
g Background

— Line Style

width: |1 = ca [ = El
Color . Jain: [ | & |
Miter limit: FE’

Cap bestemmer, om enden af et tykt linjestykke
skal veere rundt eller kantet. Join afger, om
hjerner skal vaere skarpe, runde eller afskérede.
Miter limit fortaeller, hvor skarpt et hjorne ma
vere, inden det bliver afskaret.

Er objektet Filled, kan du klikke i
farveruden og forvandle markeren
til en Dropper, der kan bruges pé
farvehjulet.

Fill 5tyle
Colaor;
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En af fordelene ved at arbejde med vektorer er,
at objekterne bibeholder deres geometriske
egenskaber, selv om figurerne midlertidigt
fremstar i deres farvede raster-udgave. S
leenge figurerne ligger pa et vektor-lag, kan de
enkelte punkter (pa engelsk: nodes) redigeres
om og om igen.

EI Prov nu at veelge verktojet Vector

Object Selection og indkreds figuren.

Nar du dernast pa Options panelet klikker pa
Node edit, er du tilbage, hvor du startede:

Wi Image 1 =] E3 || §i Image 1 M= E3

1 T\E/F

For at lere vektorer nermere at kende skal du
prove at lave figuren om til et hjerte.

Y

Du treekker i de to nederste
punkter, sa de kommer til at
ligge oven i hinanden. Med
Vector Object Selection
indkredser du de to punkter.

Nu hgjreklikker du pé
billedet og veelger Edit
->Join Select.

Join betyder: forbind.

Kommandoen

sammensvejser altsa de

selectede punkter. Hvis

punkterne ikke daekker

hinanden helt, bliver de

forbundet med en ny streg.

Du kan markere punkter enkeltvis ved at
klikke pa dem (sa de bliver sorte). Holder du
Shift nede imens, kan du markere flere 1 traek.

Under Edit har den omtalte hejreklik-menu
flere muligheder:

Ctrl+d

Delete Del Delete fjerner det
— markerede punkt.
Merge  Chrl+hd Merge gor det sam-
Break Ctrl+k me, men uden at
Close  Shift+Ctr+C klippe i elastikken.

For at kontrollere, om dine
punkter vitterligt er blevet
svejset sammen, forlader du
Node Edit ved at klikke
uden for billedet.

Du vender tilbage til redigeringen ved igen at
klikke pé veerktejet Vector Object Selection.

Da figuren allerede er

selected, behover du ikke Er/
indkredse den, men kan uden

videre klikke pa Node Edit.

Nu skal de to gverste punkter
@ndres fra skarpe (Cusp) til
blade punkter (Smooth). Du
markerer ét af punkterne og
hgjreklikker pa billedet.

Du valger Node Type og ser folgende menu:

I dette tilfeelde Asymmetric Shift+Ctrl+S

\éaelger du_ Symmettic Ctrl+5
ymmetric B il

(som er

nemmest at SmoothfTangent Ctel+T

bruge).

Punktet bledgeres nu med en

tangent, der ligner en pil. At den

er symmetrisk betyder, at dens to

halvdele (bagved og foran og a
punktet) altid er lige lange. Ved at

treekke 1 pilens to ender kan du a
@ndre dens retning og leengde. )\1

Nér du har
o ordnet
begge
punkter, er
dit hjerte
feerdigt.

Pa en eksisterende figur kan du tilfeje nye
punkter ved at holde Ctrl-tasten nede, mens du
klikker pa den pageldende del af kurven.

vektor-kurve har en bestemt
retning: fra sit startpunkt til sit
endepunkt.

I(E“__ Laeg i ovrigt merke til, at enhver

START  EMD
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Faerdige figurer

Med veaerktejet
Preset Shapes
kan du tilfgje
feerdige vektor-
figurer.

Prov som en ekstra
ovelse at hente en
cirkel og lav den
om til en
hjerteformet figur.

. v d
@
>

Tekst pé en kurve

De skrifttyper, du bruger i Windows, er alle
lavet pa grundlag af vektorer. Denne egenskab
gor det muligt at {4 en tekst til at folge en
kurve, du har tegnet.

Beslutter du
senere at
@ndre kurvens
forleb, folger
teksten med.

O—0O

fal
Lr

Pa Layers-panelet kan du se de to objekter:
Drawing og Hallo.

Den vektoriserede tekst lader sig oven i
kabet redigere som en selvsteendig kurve. Det
gor du ved at hgjreklikke pé billedet og vaelge:

Corvert Textto Curses » |

Via under-menuen kan du gere hele teksten til
et samlet objekt (Single Shape) eller udpege
de enkelte bogstaver som hvert sit objekt:

As Single Shape
As Character Shapes

Start med at lave =
den kurve, du /”'-—-: E‘)I o0—0
vil bruge. O

Nar du dernaest vaelger tekstveaerktojet (tast X)

og farer markeren ind over kurven, skifter den
udseende til et bogstav med en bue under. Med
et klik far du nu adgang til boksen Text Entry.

Text Entry |
—Fonts
Mame: Size:
ITimes Mew Rarman j |24 j
—Create As
% Yector = Flaating
= Selection ¥ Antisliaz

Enter Text Here:

Hallo|
Cancel |

Her vaelger du Create As Vector og skriver
din tekst (der far samme farve som
forgrundsfarven). Da du har frembragt
tekstboksen ved at klikke pa kurven, bliver de
to objekter automatisk forbundet, sa teksten
folger kurven.

Character Shapes gor det muligt at endre
udseendet pa et bestemt bogstav, f.eks. dit a.

1aly Yal)

Du indkredser det pagaldende objekt med
Vector Object Selection. Da din selection kun
kommer til at omfatte de objekter, som helt og
holdent er indkredset af dit rektangel, skal du
gore det rigeligt stort uden at medtage nabo-
bogstaverne.

Efter at have valgt Node
Edit kan du redigere
punkterne. Med Vector
Object Selection (eller
med Shift-klik) kan du
f.eks. indkredse en hel

gruppe.

Det eneste format, der
kan gemme dine
vektorer, er det indfadte
PSP. Alle de ovrige
filtyper vil omsatte
vektorerne til raster, nar
du gemmer billedet.
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Billedtyper

PSP kan abne, bearbejde og gemme et imponerende antal typer af billedfiler.
Til husbehov far du imidlertid kun brug for nogle fa, hvoraf de mest almindelige gennemgas her.

PSP

PSP (forkortelse for Paint Shop Pro) er
programmets indfedte filtype, der kan lagre
specielle funktioner som lag, maske, vektorer,
farvekanaler m.v.

Formatet er velegnet til at gemme et
igangvarende arbejde, som senere skal
genoptages pa samme computer. Til udveksling
med andre er denne filtype mindre velegnet,
fordi den kraver, at modtageren har samme
program.

Pa grund af de udvidede funktioner i version
6 kan PSP-filer fra denne version desvearre
ikke ikke &bnes i tidligere versioner (5 og
nedefter).

BMP

BMP er et haederkronet billedformat til brug i
Windows. Det er meget anvendeligt pa grund
af sin udbredelse, men filernes starrelse bliver
hurtigt et problem. En serlig variant (subtype)
RLE (Run Length Encoding) nedsztter
filsterrelsen ved at erstatte lange serier af ens
pixels (f.eks. store ensartede flader) med
pladsbesparende koder. I dag anvendes RLE-
typen dog kun sjeldent.

Du kan opné en anselig besparelse ved at
komprimere et stort BMP-billede med
pakkeprogrammet Zip.

TIF

TIF (Tagged Information File) er en moderne
faetter til BMP. Formatet er meget anvendt til
billeder, der stammer fra scanner eller digitalt
kamera. En af formatets varianter er presset
sammen med den hederkronede
komprimeringsmetode LZW, (opkaldt efter
forbogstaverne pa ophavsmandene Lempel, Ziv
og Welch).
Med LZW kan du effektivt nedsatte
filsterrelsen uden at forringe billedets kvalitet.
TIF er fremragende til billeder med mange
farver, der ikke skal overfores via nettet.

JPG

Formatet JPG (Joint Photographers Group) er
udarbejdet af en ekspertgruppe af fotografer,
som har lagt afgerende vaegt pé at presse
filsterrelsen helt i bund.

Desvarre sker komprimeringen pa
bekostning af billedets kvalitet: de farver, som
det menneskelige gje har svert ved at skelne fra
hinanden (blandt de 16 millioner), bliver
simpelthen skrzellet vaek. Selv om der er alt
mulig grund til at neere tiltro til ekspertgruppens
demmekraft, skal du bruge JPG med omtanke.
Hvis du i din iver efter at begrense storrelsen
pa en fil har presset de sidste vitaminer ud af
billedets farver, kan du ikke bagefter fortryde.
Bordet fanger!

Compression

Nér du i Paint Shop Pro Save As B E1
gemmer en fil i JPG-

formatet, kan du under Gem

Options indstille graden
af Compression:

thiu:uns.i}} |

Save Options
Compressian Iﬁ
Lowest compression, tlS Highest compreszzion,
best quality [west quality

En hejere veerdi giver mere kompression, dvs.
mindre filstorrelse og ringere kvalitet. Du kan
ikke pé forhand vide, hvornar tallet (der kan
variere fra 1 til 99) bliver sé hejt, at det tydeligt
forringer kvaliteten - det afhanger bl.a. af
billedets farver. Som regel kan du gé helt op til
50, uden at tabet bliver synligt.

I version 6 af Paint Shop Pro kan du finde
et veerktoj, der umiddelbart viser virkningen af
en kompression (se side 49).
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Prov at abne billedet Cox.jpg, der fylder 128
KB og gem det som Cox25.jpg med en
kompression pa 25. Gem dernast dette billede
som Cox50.jpg med en kompression pa 50.
Tredje gang gemmer du det som Cox75.jpg
med en kompression pa 75. Og til sidst som
Cox99.jpg med en kompression pa 99.

I denne proces kunne man frygte, at
komprimeringen af et allerede komprimeret
billede ville medfere en uoverskuelig
forringelse, men sadan er det heldigvis ikke.
Abner du f.eks. et billede, der i forvejen er
komprimeret med 50, og gemmer det endnu
engang med samme kompressionsverdi, vil den
samlede kompression forblive uendret. En gget
sammenpresning finder forst sted, nir det nye
tal er storre end det eksisterende.

Du skal endvidere
vaere opmarksom pé,
at billedet pa skaermen
ikke umidelbart andrer
udseende, selv om du

B Cox99.jpg [1:1]

gemmer det.
W|W Edit “iew Kompressionens
New. .. indflydelse pa
Open... billedkvaliteten bliver

forst synlig naeste gang,
du &bner billedet. Dvs. du

1 Cox99 | po

2 Cox75.jpg skal lukke det og dernaest
E CoxEDl dbne det igen, f.eks. ved
- P at klikke p4 filnavnet

4 Cox2h jpg

forneden pé rullemenuen
File.

Pa billederne med de laveste vaerdier, kan du
nappe se den store forskel.

Cox99.jpg er derimod
et skoleeksempel pa,
hvor galt det kan ga,
nar kompressionen
forvraenger bade farver
og former.

B Cox99.jpg [1:1]

i

Stare ikoner | Kigger du i den mappe,
Smd ikoner | Dvor dine billede.r ligger,

. kan du sammenligne
Creersigt

storrelserne pa de nye filer
[« Dealer ) RSO

Encoding

@verst pa Options kan du vaelge Encoding.

Encoding er Save Options | X
den reekkefolge, Encoding—————————

som de enkelte
pixels anbringes
1, nar billedfilen
oprettes.

% Standard encoding

" Progressive encoding

Ved Standard encoding anbringes
farvepunkterne pa en sddan made, at billedets
gverste del vises forst. Billedet toner frem som
et rullegardin, der hives ned.

W’!‘i"-' N

Ved Progressive encoding dukker
farvepunkterne op i spredte linjer. Du ser hele
billedfladen samtidig - med stigende
tydelighed.

[y

ﬁﬂi

i
|

_——

-

b

|
I
|

Det sidste kan vaere en fordel, nar du bruger et
JPG-billede pa en hjemmeside, fordi leeseren
meget hurtigt kan danne sig et helhedsindtryk.

Pa Internettet bor du bruge JPG med
omtanke. Lige sa fortraeffeligt formatet er til
fotografiske billeder, lige sd malplaceret er
det til tegninger og lignende grov grafik,
hvor 256 farver er fuldt tilstreekkelige.

48 © Steen Juhler, 1999, 2002



JPEG Saver

Version 6 har et vaerktej til kvalitetskontrol af
billeder, der skal gemmes som JPG-filer.

Du finder JPEG Saver under File->Export
->JPEG File..

JPEG Saver =]

Compressed:
1.471 bytes

Jncompressed:
102 B5E buytes

Cuzlity | Fu:urmatl Download Timesl

Set compreszion to |90

=

=

o]

Verktejets store styrke er, at du med det samme
kan se virkningen af en kompression - bade i tal
og pa provebilledet til hgjre. Takket vaere
zoom-knapperne kan du undersgge det nye
billede i detaljer - for at se, hvornér tabet i
farvernes kvalitet bliver kritisk.

Nér du gemmer billedet, sker det via
dialogboksen Save As, sa du kan give den
@ndrede udgave et nyt navn og beholde det
oprindelige billede.

Pa fanen Format kan du velge encoding.

et

_E‘\ Jze ﬂizardl

GIF

Pa Internettet er GIF-formatet er en sand
klassiker til mindre billeder med 256 farver. Det
handler iseer om logoer, knapper, ikoner,
diagrammer og sma tegninger, der ikke giver
sig ud for at ligne fotografier.

GIF-billeder er komprimeret med LZW, den
samme skansomme metode, som anvendes til
TIF. Komprimeringen er indbygget i formatet
og kan ikke justeres.

GIF findes i to versioner 87a og 89a,
opkaldt efter de arstal, hvor de fremkom. I dag
bruges hovedsagelig den nyeste version, der
tillader transparency og animationer.

Farvedybde

De maksimalt 256 farver, som en GIF-fil skal
ende med at indeholde, behaver ikke at begran-
se dig undervejs. Vil du have det fulde udbytte
af funktionerne i Paint Shop Pro, ber du
arbejde med en farvedybde pa 24 bit og forst
reducere farveantallet, nar resultatet skal
gemmes som en GIF-fil.

Farvedybden kan reduceres pé flere mader:
1) Med Colors—>Decrease Colors
2) Automatisk ved blot at gemme som GIF
3) Med Colors—>Load Palette

Bruger du Decrease Colors, kan du velge
forskellige metoder som vist pé side 21.

Den automatiske metode bruges, hvis du pa
et billede med stor farvedybde taster F12
(Save As) og udpeger GIF som filtype.

Filtupe: IEn:-mpuSer'-.fe Graphics Interchange [“.gif];l

Dr. Halo [*. cut]

Encapsulated PostScrpt [*.epz] |-
GER Paint [*.imag)

JPEG - JFIF Compliant [*.jpg; . jif . jpeg) =

Bemerk, at filtyperne stér alfabetisk ordnet
efter deres officielle navn. GIF star nasten
helt foroven under betegnelsen
CompuServe Graphics Interchange.
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Gemmer du som GIF, vil programmet tilbyde
dig at reducere farveantallet til maks. 256:

Paint Shop Pro b |

The zaved file wil be limited
ko a maximunm of 256 colors,
YWhiould you like bo continue?

Mej

Reduktionen foregar med en raekke standard-
indstillinger (eller efter den metode, du
anvendte, da du sidst lavede Decrease), og
altsa uden at du bliver spurgt om
fremgangsmaden.

Skal din GIF-fil bruges pé Internettet, er du
bedst tjent med at bruge den tredje mulighed,
Load Palette, der sikrer, at billedet far en
hensigtsmaessig palet.

Palet

Som navnt pé side 22 er et GIF-billedes 256
farver ordnet og nummereret i en palet.

Pa Internettet spiller paletten en afgerende
rolle, fordi billedet skal ses af mange brugere
med forskellige computere og programmer.

Lad os sige, at du har anbragt nogle GIF-
billeder pa en hjemmeside, som senere hentes af
en bruger med 256 farver pé sin skaerm. S
snart det ferste billede dukker op, vil
modtagerens skarm tilpasse sig efter de farver,
det bestar af. Billedets palet vil diktere
skermen, hvordan hver af de 256 farver skal
gengives.

Lad os dernaest antage, at det naeste billede
indeholder 10 farver, som ikke er med i den
eksisterende palet. Da der kun er 256 farver til
radighed, kan de nye farver kun vises ved at
blande de farver, som allerede er defineret. Det
kan give besynderlige resultater.

Du skal derfor bestrabe dig pa, at billeder
pd en hjemmeside har samme palet.

Selv om du opfylder denne betingelse, kan du
lobe ind 1 vanskeligheder, fordi visse farver har
forskelligt udseende fra den ene web-browser til
den anden.

Du kan risikere, at et billede, der ser nydeligt ud
i en Windows-udgave af Internet Explorer,
virker kornet og grumset i en Netscape-
browser pa en Mac-computer. Og omvendt.

Det geelder altsa om at bruge en palet, der
har samme udseende pa alle maskiner.

Det kan du opna ved at anvende en sékaldt
sikker palet, der bestér af 216 farver, som
gengives ens i alle browsere. De 40 resterende
farver skal vere til radighed for
styresystemerne pé forskellige maskiner - sa
dem mé du undvere til dine billeder.

Du forsyner et billede med en palet ved at
vaelge Colors>Load Palette:

Load Palette HE
Sogi Ia Palethes ;I gl E

I Safety. pal

Filtyaer: ISafet_l,l pal Abn

Fitype: |PAL - Palette File ~ | Annuller |

I programmets medfelgende mappe Palettes
ligger den sikre palet Safety.pal, som du kan
bruge til billeder, der skal pa nettet.

Nar paletten 2pply palette using
anvend_es’ skal = Mearest color matching
du anglV.e cn (-%_rn:ur diffusion dithering
metoqe til " Maintain indexes
justering af

farverne.

De to forste muligheder er de mest relevante:

Nearest color.. oversatter
hver af originalens farver til
den, der ligger nermest i den
sikre palet. Resultatet vil ofte
blive lidt blakket i stil med
fotografik.

Error diffusion.. skaber flere
mellemtoner, fordi de nye
farver optraeder i kornede
mgenstre (Dither). Med sine
synlige raster ligner resultatet
et forsterret farvefoto.
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Maintain indexes betyder, at de eksisterende
farvenumre skal bevares. Denne (sjeldne)
mulighed kan kun bruges, hvis billedet i
forvejen bestér af det samme antal farver som
paletten.

Paint Shop Pro b =

The palette file and current image
do not contain the zame number of colors.

Nar billedet er forsynet med Safety.pal, kan du

se de anvendte farver ved at vaelge Colors—>
Edit Palette:

Edit Palette

Sort order; I Palette Order ;I

De forste 216 pladser i paletten er de farver,
som billedet skal besta af for at kunne ses ens i
alle browsere. De sidste 40 pladser er dem, der
er reserveret til systemet (Windows eller Mac),
og som bruges til ikoner, menuer og lignende:

Et billede, der bruger Safety.pal, kan frit

plukke af de 216 farver, og overlade det til
laeserens web-browser at kaste sig over de
resterende.

Ved reduktion fra 24-bit til 256 farver skal
du savidt muligt g& ud fra et billede, hvis
farver ikke i forvejen er forringede ved en
kompression. Selv om et JPG-billede ofte
kan endres til GIF med et haederligt
resultat, vil det samme billede i BMP eller
TIF (selv i de komprimerede udgaver) fore
til de flotteste farver.

Transparency

GIF giver mulighed for at udnavne en af
palettens farver som transparent ved at veelge
Colors—>Set Palette Transparency:

Set Palette Transparency |

" Mo transparency

% Set the hansparency value
to the current background color
£ Set the hansparency value

to palette entry ID _|:

EIK[:: | Proof |

Det enkleste er forinden at udpege den enskede
farve i billedet som baggrundsfarve (ved at
hgjreklikke pa den med Dropper) og sé veelge
den midterste mulighed ..current background
color.

Kender du ligefrem palettens indeks-num-
mer for den pégeeldende farve (som ses med
Edit Palette), kan du skrive det i ruden palette
entry.

Klikker du pa knappen Proof, bliver den
valgte farve straks gennemsigtig i billedet pa
skeermen.

Transparency skal velges, inden du
afslutningsvis gemmer din GIF.

Interlaced

Under selve gemme-
processen - i dialogboksen
Save As - kan du finpudse
GIF-filens endelige detaljer.

Gem

thiu:uns..[: |

YWerzion———— 1 Interlacing

£ Version 87a
* ersion 89a

&+ |nteraced

i~ Moninterlaced

Interlaced svarer til JPGs progressive
encoding, hvor billedet toner gradvist frem i
form af vandrette streger.

© Steen Juhler, 1999, 2002 51



Transparent GIF Saver

Lige som til JPG-filer har version 6 et verktej
til kvalitetskontrol af billeder, der skal gemmes
som GIF-filer. Du finder Transparent GIF
Saver under File>Export > Transparent
GIF File..

Som navnet antyder, gores der en del ud af
billedets Transparency, men fanen med
Colors er mindst lige sa anvendelig. Det er en
stor fordel, at du med det samme kan se
resultatet af dine @ndringer i den hejre rude
foroven.

Transparent GIF Saver |

Zoom 1:3
al af
[=]

IJncompressed: Compressed:
102 E5E bytes 16.723 bytes
Transparency | Colors I Format

i~ Maone

¥ Existing image or layer transparency

" Zreas that match this color -

Tal E
Tolerance |4 =

o]

Verktejet har en speendende fane (ikke vist pa
ovenstaende illustration), hvor du kan tage stil-
ling til delvist gennemsigtige dele af dit billede
(Partial Transparency). Du kan bruge et
farvemenster (Dither) til at opnéa denne
virkning.

Fanebladene er tilstreekkelig informative til,
at du kan undga Use Wizard, der stort set stil-
ler de samme speorgsmal.

Nar du gemmer billedet, sker det via
dialogboksen Save As, sa du kan give den
@ndrede udgave et nyt navn og beholde det
oprindelige billede.

}*\ Jze ﬂizardl

PNG

PNG (Portable Network Graphics) er et nyt
format, der spés en gget anvendelse pa
Internettet. PNG er forst og fremmest lavet for
at undgé de licenser, der er knyttet til
anvendelsen af GIF. Den feromtalte LZW
kompression er nemlig omfattet af et patent,
som lagger en afgift pa programmer (deriblandt
PSP), der bruger denne komprimering som et
led i deres software.

PNG kombinerer nogle af fordelene ved
bade GIF og JPG: frit valg mellem 256 og 24
bit farver, bedre kompression uden kvalitetstab
(og uden licens) samt interlace bade vandret og
lodret pa én gang.

Endnu har mange programmer problemer
med at vise PNG, f.eks. a&ldre web-browsere og
web-editorer (programmer til at lave
hjemmesider med).

En web-browser som Internet Explorer 4
kan f.eks. godt vise et PNG-billede, hvis det
hentes som en del af en hjemmeside. Hvis
billedet derimod treekkes direkte over i
browseren fra en mappe pa din computer (som
det kan lade sig gore med GIF- eller JPG-
billeder), vil det ikke blive vist. I Netscape 4
er der tilsvarende problemer. Der vil derfor gé
et stykke tid, for PNG-formatet rigtigt slar
igennem.

MNG

Til at erstatte de animationer, som kan hand-
teres af GIF 89a, er der udviklet en feetter til
PNG med navnet MNG (Multiple-image
Network Graphics).

I lighed med PNG kan MNG rumme 24 bit
farver og bruge den samme effektive
kompression, der hverken forringer
billedkvaliteten eller kraever licens. Disse
fordele er en medvirkende arsag til, at MNG
bruges som det indfedte format i flere
animations-programmer, bl.a. i Animation
Shop (se side 55).

P& grund af den begransede udbredelse kan
formatet endnu ikke anbefales til almindelig
brug pé din hjemmeside.
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Billedbrowser

PSP har indbygget en fortrinlig billedbrowser. Ordet browser, der kan forveksles med dit program til
at finde sider pa Internettet, skal forstés i sin oprindelige (engelske) betydning: at finde graesgange.
PSP Browser laver et overskueligt album af billeder i miniformat, som kan bruges til filhandtering.

Nar du har PSP dbent, kan du til enhver tid
valge File>Browse.

[SI=W Ecdit “iew
[l e Cirl+
Open..  Cil+0
Browse. . Cirl+B

Billedbrowseren, der
har genvejen Ctrl+B,
vil automatisk starte
med at vise den
mappe, du sidst
kiggede i.

I venstre side ses et
mappevindue, hvor
~+{_] Ballan du kan klikke dig
-1 Hunde frem til en ny mappe,
{7 Ikorer som skal fremvises.
| Browseren gar straks
{1 MoriLisa i gang med at fordeje
-] Siove GIF LI mappens billeder.

=] Grafik ;I
F-L ] Animerede

Albumvinduet viser i hgjre side en reekke mini-
udgaver (Thumbnails) af billederne. Du kan
markere enkeltbilleder med et klik eller flere
ved samtidig at holde Ctrl-tasten nede.

De markerede billeder far en farvet baggrund.

CASIC.BhP

CAMOR BhP

HODAR BhiF nikan jpg nikon2 jpg
pEpra? 0 jog sonyd] jpg sonyST jog

I version 6 kan browseren vise vektor-billeder.

De vigtigste menupunkter fra PSP forbliver
uendrede, mens browseren kerer, men der til-
fojes et par nye, bl.a. ImageFile:

Co pyig

Herfra kan du kopiere,

slette, flytte og omdebe
Delate markerede billeder.
= Punktet Open Image, der
Move.. dbner billederne i PSP,
Bename... kan ogsé klares med et
Inia dobbeltklik pa hvert
S enkelt billede.
Open Image

Menupunkterne fra ImageFile fremkommer
ligeledes, nar du hgjreklikker pa et billede.

Nar du ferste gang besgger en mappe med
browseren, laves der nye thumbnails, som gem-
mes i en seerlig fil, pspbrwse.jbf. Under File
—>Preferences—>General.. kan du fastleegge,
hvorvidt filen automatisk skal opdateres:

Paint Shop Pro Freferences |

Mizcelaneous I Rulerz and Unitz I
Ilnhdo I ieming I Browser

T hurnbnail zize Selection color
¢ B0 = F0

& g ]
Change... |

= 100 % 100
© 120%120
¥ Save Browser files ta disk

¥ Automatically update the thumbnails

EIK[_: I Annuller |

Hvis du laver en Capture (se side 54) af dit
album, kan du lave mini-billeder til brug pa din
hjemmeside. Husk forinden under Preferences
at veelge en passende Thumbnail size.
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Capture

Capture-funktionen bruges til at hente billeder fra skeermen ind i PSP til videre bearbejdning.

Windows har to tastatur-genveje til at indfange
billeder: et tryk pa PrtScr fanger hele skaermen,
mens Alt+ PrtScr kun medtager det aktive
vindue. PrtScr (Print Screen) er den
specialtast, der sidder oven over tasterne Insert
og Delete.

Brugen af genvejen ivaerksatter en
kopiering: billedet overfores til computerens
hukommelse (klippebordet), hvorfra det kan
hentes ind i stort set alle Windows-programmer
med Ctrl+V (Paste).

Capture, der har sin egen menuoverskrift i
PSP, er en udbygning af denne funktion.

Inden du starter din
forste Capture, kan du
indstille detaljerne ved
at veelge Setup..

Capture Setup Foruden Full screen og

Window kan du valge
at fange Area (et
omrade du indkredser
med musen), Client
 Ciient area area (det aktiye vindue
minus menubjzlker)
w/indov eller Object (et bestemt
" Object objekt, som du har
markeret med musen).

Capture  [iilylsta

Start Shift+C

— Capture
= fiea

" Eull zcreen

Din Capture vil
normalt starte ved,
at du trykker pa en

—&ctivate capture using—

" Right mouse click

& Hot key Hot key (en tast
| F11 = I eller kombination
= Delay timer af taster), som du

selv har defineret.
F11 er et godt valg.

|2 _% zeconds

Udgangspunktet for en Capture vil altid vere,
at du har Paint Shop Pro dbent og taster
genvejen Shift+C. Programmet kvitterer straks
ved at blive minimeret til en knap pé
proceslinjen (for ikke at veere i vejen). Forst
derefter trykker du pa din Hot key.

Har du valgt at fange et Area, vil din marker
skifte udseende til et sigtekorn (et kryds). Du
klikker pa everste venstre hjerne i det areal, du
vil fange, og slipper s& museknappen.

Fra det sted, hvor du har

o klikket, vil der nu udga et
rektangel, hvis modstdende
{0x80 hjerne du kan flytte frit.

Papirk i

Undervejs kan du se
arealets storrelse i pixels.

Nér rektanglet har den enskede storrelse,
klikker du igen, hvorved arealet indfanges.

Hvis du ikke har valgt Multiple
captures (og altsa er ferdig i >
denne omgang), vender ﬁ’
programmet automatisk tilbage i

sit tidligere vindue, hvor du vil
finde arealet som et nyt billede.

] Imagel

Papirkury

Har du sat hak ud for Multiple captures, kan
du gentage processen ved at klikke endnu
engang pa din Hot key. Hver indfangning sker
diskret og helt lydlest. Hvis du er heldig, kan
du registrere en lille @ndring p& programmets
knap nede pé proceslinjen, hvor nummeret pa
hvert enkelt af de nye billeder (maske) kan ses.

Naér du til sidst maksimerer programmet, vil
billederne ligge klar til brug.

Include cursor
medtager markeren,
hvis den er med i
billedet (og altsa ikke
ved Area).

O ptians
V¥ Include cursar

¥ Multiple captures

Vil du indfange billeder fra selve PSP-vinduet,
er du nedt til at have to programvinduer abne:
det forste (som straks minimeres, nér du starter
Capture) til at styre processen - og et andet
som mal for indfangningen. De fleste af
illustrationerne i dette haefte (bl.a. med
billederne af de specielle markerer) er lavet
efter denne recept.
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Animation

En animation er et billede, der bevager sig som en lille tegnefilm, nér det vises i en web-browser.
I Animation Shop, der folger med Paint ShopPro, kan du lave animationer ud fra enkeltbilleder.

Du starter AnimationShop ved at vaelge
File=>Run AnimationShop.

VTRV i For at se, hvordan

File “iew Help programmet virker,

abner du forst en
|Eo & |

eksisterende animation
JJ "] Q i mappen Anims.

Anims er en undermappe til den mappe, hvor
du har Paint Shop Pro liggende, og her abner
du filen bttrfly.gif.

Open _________HE]
Segi Ia.ﬁ.nims YI il
. @ rurner. gif

) hooked.gt (] thttrfly. gi
8] Mailtrim.Gif - ] thttfly.mng
Filnawr:  [btrly. gif b

Filtype: I.-i'-.ll Files "I ,.f_-.,nnullerl

" Image information

Yfidth; 50 Height: 50

I en mappeoversigt kan du ikke umiddelbart se,
om en GIF-fil er animeret eller ¢j. Mappen
Anims indeholder imidlertid udelukkende
animerede filer, der er stykket sammen af
enkeltbilleder.

= bttrfly.gif [1:1] - Frames

F1 015 F2 15 F3 D15 F4 [:15

Billedet dukker op i et vindue med Frames.

ILI Du kan forskyde indholdet
J med rulleskakten forneden.

Hver frame har et nummer F:1, F:2 o.s.v.
Tallet efter D: oplyser om Display Time for
hver enkelt frame: hvor mange hundrededele af
et sekund, den skal vises.

Nér du har kigget pa strimlen

el med View Frames, kan du
se selve bevagelsen ved at

klikke pa View Animation.

Du ser nu sommerfuglen
blafre med vingerne i et

& bttr... =] E3

-

selvstaeendigt vindue, w
som du kan gore storre
eller mindre med

Frame 2 of 8

tasterne [*] eller [=] .

Nu skal du prove at flytte en frame til et nyt
sted pa strimlen. Du peger med markeren pa
den forste frame F:1 (der straks far et kulort
omrids som tegn pé, at den er markeret) og
traekker den hen til mellemrummet mellem F:3
og F:4, hvor den slippes. Undervejs ligner mar-
koren to dokumenter med et tredje imellem
(forsynet med et plus).

F1 D15 F2 D15 F3 D15 F4 D&

Straks du slipper, flytter billedet hen pa den nye
plads. Samtidig skifter numrene, sa den
tidligere F:2 nu bliver F:1 o.s.v.

F1 D15 F2 15 F3 D15

F-4 D:15

Hvis du treekker og slipper oven pd en frame,
erstattes den af det nye billede. Hvis du traekker
med Ctrl-tasten nede, kopieres billedet - dvs. at
den oprindelige frame bevares uzndret.
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Treekning af billeder mellem de enkelte frames
er ikke den mest pracise méade at arbejde pa.

Du kan nemt risikere at slippe
billedet, sa motivet ikke rammer
ngjagtig det samme sted i forhold
til rammen - og det er skidt.

Sa er det mere overskueligt at bruge de vante
genveje, som alle findes pa den menu, der
fremkommer, nér du hgjreklikker pé en frame:

Sawve Frame As... |

Cut Ctrl+
Copy  Chl+C

As MNew Frames Ctrl+4

Imto Selected Frame Cil+E

Delete
Cuplicate
Froperies... Ermpty Frames

Image Transitian...
Text Transitian. ..

En ny frame (enten som et billede From File
eller som Empty Frame) indseattes altid til
venstre for den markerede.

Er du kommet til at lave kludder i en
animation, kan du altid g tilbage til den
oprindelige fil med File>Revert.

Lav en ny animation

Du starter i Paint Shop Pro med at lave tre
simple GIF-billeder, som bagefter skal bruges
til en animation.

Du velger File>New og velger en
starrelse pa 50 x 25 pixels (Resolution 300
pixels per inch) i 24-bit farver med
baggrundsfarven White. Pa farvepanelet
dobbeltklikker du pa forgrundsfarven og velger
en sterk rod.

Forster billedet til 8:1 ved at trykke 7 gange
pa tastaturets plus-tast helt ude til hojre.

Nu aktiverer du tekstverktejet ved at taste X
og klikker derneest midt i billedet. Vealg
skrifttype Arial, Normal, 18 pkt. med Antialias
og Floating. I tekstruden skriver du AHA med
store bogstaver og klikker derefter pa OK.

Med ytepilen
| fremme skubber
: :4-T-p : du teksten helt
== [ ned 1 underste
"N F venstre hjorne og

hejreklikker.

Nu forsyner du
billedet med den
sikre palet (se side
50) og gemmer
det som bund.gif.

=10 x|

AHA

De folgende billeder laves alle ud fra bund.gif.
Pé det naeste billede skal du fa det midterste
bogstav til at hoppe lidt. Du serger for, at din
baggrundsfarve er hvid, taster S og laver en
rektanguleer selection (uden feather), der netop
medtager bogstavet H. Nu forer du markeren
ind 1 din selection, sé flyttepilen bliver synlig.

WL Ll - O] x]| Mens duholder

Shift-tasten nede,
trykker du tre
gange pa pil-op-
tasten.

B! bund.gif

Herved flytter du din selection ngjagtig 3 pixels
opad. Uden at fjerne din selection taster du F12
og gemmer billedet som midt.gif.

B midt git~ =] Du holder atter

Shift-tasten nede,

mens du trykker
tre gange pé pil-
op-tasten.
Resultatet gemmer du som top.gif.
De tre GIF-billeder bund, midt og top
ligger nu gemt pa harddisken og kan hentes ind
som frames i Animation Shop.

01 bund, KL !
I top. M B3

AH|AH Ha
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Du starter Animation Shop og valger New:
Create New Animation |
Animation Properties

ﬂidth:lED 3: ] Hgight:lEE 3:

¢ Tranzparent © Opague

(o

Du saetter storrelsen til 50 x 25 pixels pa en
Transparent baggrund (canvas).

Nar du klikker OK, ser
du en ny animation

F1 010 med tomme frames.

Cancel |

Du hgjreklikker pé den markerede frame og
veelger Add->From File..

I ruden kan du
nu tilfeje de
filer, der skal
bruges, ved at
klikke pa Add

&dd File.lj | File..

Insert Frames from Files

Open [2]x]| Du finder mappen,
Seqi I'a Images vI
] bund i

hvor du har gemt de
tre GIF-filer, og

markerer dem, mens
du holder Ctrl-tasten

. it
1] top.gif] % nede.

Nér du bekrefter Open med OK, dukker de tre
filnavne op i Insert Frames from Files:

Insert Frames from Files |

o G e Mave g |
rridt. gif
tove Down |

top. gif

tddFie.. | RemoveFile | | DKE I

|' Flacement of new frames

Inzert before: E Delay bime: I'IEI _IQ

Med knapperne Move Up og Move Down kan
du flytte filerne, s rekkefolgen bliver rigtig.

Naér du klikker pa OK, settes de tre filer ind i
hver sin frame:

AHAAHARAHAN

F1 D0 B2 D0 F3 D0 F4 Do0

For at animationen skal blive jeevn kopierer du
midt.gif (som ligger i F:2) til den tomme frame
F:4. Du markerer F:2 og taster Ctrl+C (Copy).
Derneest markerer du F:4 og taster Ctrl+E
(Paste into Selected Frame).

F1 D0 F2 D0 B3 10 R4 Do

Nu kan du se resultatet /ive ved
L at klikke pa View Animation.

[View Arimation|

Inden du gemmer animationen, skal du endre
Display Time for den forste frame til 1 sekund.

Du hejreklikker Frame Properties E |

pa F:1, veelger _ _
Properties, og Display Time | Comments |

&ndrer tallet til
100. Tallet for
de ovrige frames
er fortsat 10.

Dizplay tirme =
(in 1100 sec): |10 =5

DKI:{ I Annuller |

Nu taster du F12 og gemmer animationen som
Aha.gif i mappen Anims.

Animation Shop har to filtyper, du kan
bruge, nar dine animationer skal gemmes:
GIF og MNG.

MNG (Multi-Image Network Graphics) er
programmets indfodte format, som
anvendes, mens du udarbejder din
animation. En af fordelene ved MNG er, at
du kan bruge 24 bit farver og alligevel opna
en behersket filstorrelse. Ulempen er, at
formatet endnu ikke kan laeses af alle web-
browsere.
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Optimering

Nér du gemmer en ny animation som GIF,
bliver du tilbudt at optimere resultatet for at
gore filstarrelsen mindre. Det foregar med
guiden Optimization Wizard, der bl.a. kan
reducere antallet af farver og fjerne overfladige
gentagelser.

Animation Quality Yersus Size 3 |

Better Ir_nage Custamn settings selected
Quality "Wwirite minimal frames

N L |Jze tranzparency
) | } Uze browser-zafe palette
- - [T Use these settings
Smaller File :
S Eustumlze.[: |

Forste gang, du bruger Optimization Wizard,
praesenteres du for en reekke
standardindstillinger, der som regel giver et
godt resultat. Har du imidlertid specielle ensker,
f.eks. om at anvende den browser-sikre palet,
skal du klikke pa knappen Customize..

Pi funcbladet [PPSR
Colors kan du

indstille Colors | Optimizations |
farveantal, palet HMumber of Colors:

0g

reduktionsmetode. |25Ei colors ;l

Her finder du bl.a.

Browser palette.
Under
Optimizations
kan du veelge
forskellige mader
at handtere
gentagelser pa.
Dine indstillinger
bliver standard
ved den folgene
optimering.
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— Create palette by—j
% Browser palette
" Octres
" Median Cut

— Reduce colors by—
¥ Nearest Color
= Ermrar Diffusion

Nar du er ferdig med optimeringen, ser du
resultatet malt i filsterrelse:

Optimization Results |

Current File  Optimized File % Change
| 1.4F. bytez

Size of file: |

¢ Tibage

Resultatopgerelsen viser desuden, hvor lang tid
det tager at downloade filen pa nettet. Nar du
klikker pa Udfar, gemmes den nye fil.

Ruderne Current (nuvarende sterrelse) og
Change (procentvis @&ndring) far betydning,
nar du optimerer en eksisterende animation med
File> Optimization Wizard.

Animation Shop 2

Det animationsprogram, der folger med version
6 af PSP er kraftigt udbygget i forhold til sin
forgaenger. F.eks. kan du med Banner Wizard
lave animerede reklameskilte til brug pa din
hjemmeside.

Desuden er der tilfgjet nye filtyper, som du
kan abne og gemme: FLC og FLI fra Autodesk
samt Microsofts AVI-format.

Animation Shop er bade i version 1 og 2
alsidige, selvstaendige programmer, som det
kreever en del gvelse at beherske.

Til en start kan du abne en eksisterende
animation og studere, hvordan de enkelte
frames er skruet sammen.
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Batch Conversion

Med Batch Conversion kan du pa samleband skifte filtype pa et stort antal billeder.

Nar du abner et billede i Paint Shop Pro og
senere gemmer det med en andet filtype, sker
der en konvertering (Conversion): alle filens
informationer om de enkelte pixels samt
supplerende oplysninger om palet,
kompression, transparens, interlace m.v.
omorganiseres, s de passer til det nye format.

Har du en raekke billeder med samme
filtype, som du ensker konverteret til et andet
feelles format, behover du ikke &bne og gemme
hver enkelt. Opgaven kan klares i én
arbejdsgang, nar du vaelger File>Batch
Conversion.

Batch Conversion | Du ébner
forst mappen
Sog i I'a Grafik, LI med de PP
oprindelige
filer. Vil du
konvertere
alle filer af
Filnawh: I"Ean_l,u:un.tif" ""Clouds b en bestemt
, filtype,
Fitype: |2l Files =l | Kiikker du pa
g | Select All.
elect Al

NB: Klikker du pa Select All efter som Filtype
at have valgt All Files (som pa illustrationen),
géar Conversion ufortredent i gang med at be-
arbejde alle filer i mappen. Vil du begraense dig
til en enkelt slags, skal den pa forhand valges
under Filype. Det sikreste er dog at handplukke
filerne ved at klikke pa dem enkeltvis, mens du
holder Ctrl-knappen nede.

Output settings vedrerer den filtype, der
skal konverteres til:

Output zettings
Type:
[JPEG - JFIF Compliant [+ jpa:* it jpeg) |

Options. E |

Klikker du pa knappen Options, kan du uddybe
detaljer ved den valgte filtype.

Save Options | Ved JPG kan

. du f.eks.
Encoding .
............................................. angive
 Standard encoding Encoding og
" Progressive encoding Compres-
sion, lige som

nar du gemmer
en fil normalt.

Compression |1 a

Output folder er den mappe, hvor de
konverterede filer skal anbringes:

Dutput falder Mappen
“E:hwet. Erowise | kan evt.
findes med
Browse.

Nér disse ting er pa plads,
kan du klikke pa Start.
Stop on error er en nyttig

funktion, hvor du kan na at ﬂl
rette en evt. fejl, inden V¥ Stapon
konverteringen lober af Efror
sporet.

Stark [: |

Processen kan endvidere afbrydes med et klik
pa Abort i konverteringens status-vindue:

Batch Conversion Status (File 1 of 5]

Current Step

Reading C:\GrafikhSeazhaore. tif

thet_|
i
5 File(s) successhully converted. |

Current Step

WOk,
Eath u:u:unversiu:un complete.

zzfully converted.

Save Log... |

Naér konverteringen er slut, kan du finde de nye
og de gamle filer i deres respektive mapper.
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Genveje

Stort set alle vigtige funktioner i Paint Shop Pro kan aktiveres med en genvej pa tastaturet.
Bortset fra genvejene til generelle funktioner og verktejer er de her opstillet efter den menu, hvor de

forekommer.

Genveje, som er market med en stjerne (%), er fzlles for en lang rekke Windows-programmer.

| |File |
Vis eller Skjul paneler Tab New CtrI+N *
Skift til naeste veerktg;j Mellemrum Open Ctrl+O *
Browse Ctrl+B
| Save Ctrl+S *
Zoom G Save As F12
Deform D Dglete Ctrl+Delete
Print Ctrl+P *
Crop R
Mover V :
Selection S | Edit |
Freehand A Undo Ctrl+zZ *
Magic Wand M Undo History Shift+Ctrl+Z
Eye Dropper Y Cut Ctri+X *
Paintbrush B Copy Ctrl+C *
Clone N Paste |New Image Ctri+Vv *
Color Replacer , (komma) Paste |New Layer Ctrl+L
Retouch V4 Paste |New Selection Ctrl+E
Eraser E Paste |Transparent Shift+Ctrl+E
Picture Tube . (punktum) Paste |Into Selection Shift+Ctri+L
Airbrush U
Flood Fill F |yiew |
Jext “ Full Screen Edit Shift+A
Shape / Full Screen Preview Shift+Ctrl+A
Normal Viewing Ctrl+Alt+N
| Image Info Shift+l
Grid Ctrl+AIt+G
Tool Bar (varktejskasse) T
Color Palette C [Image |
Control Palette 0] .
Layer Palette L :\:/:!p Clritl
irror Ctrl+M
Tool Palette (knappanel) P
Histogram Window H Rote_lte Ctr_I+R
Resize Shift+S
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| Colors | |Masks

Brightness/Contrast Shift+B Hide All Shift+Y
Gamma Correction Shift+G Invert Shift+K
Highlight/Midtone/Shadow  Shift+M Edit Ctrl+K
Hue/Saturation/Luminance  Shift+H View Mask Ctrl+Alt+V
Red/Green/Blue Shift+U

Colorize Shift+L | Capture

Posterize Shift+Z .
Edit Palette Shift+P Start Shift+C
Load Palett Shift+O :

oad Palette i |Wln dow
[Layers | New Window Shift+W
Duplicate Shift+D

Select Current Layer Ctrl+lag nr. Fit To Window Ctrl+W
| Selections |

Select All Ctrl+A *

Select None Ctrl+D

Float Ctrl+F

Feather Ctrl+H

From Mask Shift+Ctrl+S

Hide Marquee Shift+Ctrl+M

Inverse Shift+Ctrl+I

Promote Layer Shift+Ctrl+P

Defloat Shift+Ctrl+F
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Stikord

24 Ditueereieeceiiieeeeeeee 21
Actual Size ..ol 20
Adjust colors .................. 23
Airbrush.................... 12,43
Aligned.......ccocvvvveiennnen. 11
Animation............c.......... 55
Antialias ............. 13,27, 36
Apply ..o 8,33,38
ATTOW v, 8
ASSOCIEIE ....vvveeeenreeeennee. 15
Auto Proof................ 23,32
Automatic Roll-Ups ......... 6
Background .................... 37
Batch Conversion........... 59
beskaring ........ccccceeeeveuenne 7
Bezier ......cooovvennnnn. 13,44
Blend ........ooevviiienin, 37
Blue...oooveeieiiiee 31
Blur....oooveieeiiiiiei, 33
BMP ..., 47
Borders ......cccoeveeeveneen, 17
Browser .......cccoeveeeeinnnn. 53
Brush Tip....cccoevverienee 10
Bumn......ooooooooiiii 11
Canvas.......cceeevvveeeeeeenn. 19
Cap oo 44
Capture ...c..coeeereereennenns 54
Character Shapes............ 46
Clone Brush.............. 11,25
Color Replacer................ 11
Command History .......... 17
Compression................... 47
CompuServe............co..... 24
Control-panel.................. 10
COPY eeeeeereeeeereeeeeens 30
Create As Vector............ 46
Crop.cceceeeneeeieeene 7,8,16
Custom Brush................. 11
CUleiiiieeeeeeceeeeeee. 30
Darken .......cccocevveeneenenn. 11
Decrease .......cooeeuvveeeennn. 21
Defloat.......cccovvveecrvenene. 26
Deformation ............... 8, 38
Density .....cccoecvveieeienen. 10
Dither......ccovvennnnen. 21, 52
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Dodge.....ccveviiiiieieens 11
Draw......ccccoool 44
Dropper ......ccocueeeneen. 10, 22
Edit Mask ..........cccovvnnnn. 41
Emboss.....cccuvveeennn. 11, 34
Encoding ........cccveeueennens 48
Eraser............c......... 12
farvedybde.......c.cccceeueee. 21
Feather.....cccouvveeeennn. 9,26
File Open......cccccceeueenene. 14
Filled .....coovvemineiieiiinnnn, 44
Filnavn......cooovvveeiiiinnnnn. 18
filter....ooveeeiiieeeeiiee, 33
Filtype ...coovvevieieeieeens 14
Float.......oovvoeiiiiiiiiiins 26
Floating .......cccceueeee. 26, 36
Flood Fill..........ccccenn.. 12
frame ....ccoovvvvvveeeviiinnnen, 55
Freehand...........cccooon.. 9
Full Screen ..................... 16
Gaussian Blur................. 33
(S 1\ /<) [ 60
GIF oo 49
Gradient.................... 12,40
Green.....ccooveeeeeeeeeccnnnnenn. 31
Group...coooveeerieeeeeenieens 37
Hardness.........cccouveeeene.e. 10
Hotkey ...ooooveeieninienne 54
Hue..ooooo oo, 22
hukommelse ................... 18
Increase ......ccoovveveeeeennnn. 21
Interlaced.........cccuvee....... 51
Invert......cccoeeeeeeiis 30,43
JOIN ., 44
JPG .o 47
kilobytes .......ccccevuerueennene 18
lag.cceeeieieeee e, 37
Lasso ....cooovveevniiiiieieeeens 9
Lighten ......ccccccevereenene 11
Lightness ......ccccceoeveeneene. 22
Line ccoooveveeeniieeeieeeeee, 13
Magic Wand.............. 10, 28
Marquee ......c.oeeeneee.. 27,42
mMaske.......coovveveeeireeeeennen. 40
MEerge ....cocveevveeeeeeenieens 39
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Modify....ccoeeveiieiiennee, 26
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MOVE oo 26
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Node Edit ......ccovvveeennnens 45
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Opacity ......cceeveeneene. 10, 37
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Output settings ............... 59
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Paint Brushes.................. 10
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Palette Transparency ...... 24
Paste ....ooovveeiieiiees 30
Paste As New Image ........ 7
Picture Tube................... 12
Plugins........ccoeevvevvennennne. 35
| [ 52
Point to Point.................. 44
Preferences................. 5,35
Preset Shapes.................. 46
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PrintScreen.........cccccuvnenne 7
Properties .........ccccveneee. 39
Protect ......ooovvvveiiiiiens 37
PSP, 47
Push....ccooovvviiiiiiiee, 11
RAM. ..o, 18
Rectangle..........cceeneeee. 29
Red ..o 31
Resample..........ccuveneeee. 20
Resize...ccovvvveiieiieiee, 19
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Retouch .................... 11,25
Revert.....cooovvvvvvnnnnnn. 26, 33
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Rotate ....cceevevvveiieiieens 16
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Saturation ...........cceeuene. 22
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Shapes......ccceeveerereeecineenns 13 Symmetric ..........cco.u....... 45 Undo History.................. 17
Sharpen.........ccceeeveveennens 11 tabulator-tast..................... 6 Vector Object Selection . 45
Single Shape................... 46 TeXt covviiiieeieeeieens 13, 36 VEKLOTer .....covvveeveeeieens 44
SIZ@ .oooiieeiieeieeeee e 10 Text Entry.....cccceevveeennens 46 vektor-lag ........cccvveunennns 44
Smart Edge ........c..cc...... 28 Thumbnail ...................... 53 vaerktajslinje..........ccce..ee. 6
Smart Size .....cccceeveeneens 20 TIF e 47 ZOOM ..o 8
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